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Libero IDE Overview
Complete Toolset for Actel FPGA Development

Project Manager
ViewDraw Schematic Capture
Synplify Synthesis
Testbench Generation
Mentor ModelSim Simulation
PALACE Physical Synthesis (Libero Platinum)
Actel Designer Design Implementation

Compile, Place & Route
Timing and Physical Constraints
Timing Analysis
Power Analysis
Back Annotation
Programming File Generation

FlashPro Programming Software
Silicon Explorer Debug Software
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Libero Tool Suite

•Integrated 
Design 

Environment

Design 
Implementation

• Synthesis

Synplify

ViewDraw 
AE

•Schematic Capture

Actel

• SmartGen 
Macro builder

Design 
Verification

• Stimulus

SynaptiCAD

ModelSim

•Simulation

• Silicon Explorer 
Debugger

Actel

Physical 
Implementation

Actel Designer

•Programming

FlashPro

PALACE

•Physical Synthesis

•Place & Route
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Libero Gold
 World Class Fully-Integrated PC Development System

Targets All Devices up to 1M Gates
Tools:

ViewDraw AE 7.70
SynaptiCAD WaveFormer Lite 10.04a
ModelSim AE 6.1b
Synplify AE 8.5f (1M gates)
Actel Designer 7.2 (1M gates)
FlashPro 4.2
ChainBuilder 1.1
Silicon Explorer 5.1

PC Platform
Licensed to Disk ID (Node-Locked license)

1 Year Free License!
No Updates (Service Packs Available)

Tool Features
Integrated Design Management a
Schematic a
VHDL  a

Verilog  a
Macro Generation a
Testbench Generator a
VHDL Simulation                              
Verilog Simulation a
Timing Simulation a
Static Timing Analysis a
Timing Driven Place and Route a
Push Button Place and Route a
Layout Editor a
Silicon Explorer a
Standard Industry Interfaces a

Third Party Design Libraries a

Platform Support
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Libero Platinum

Targets All Actel Devices
Tools

ViewDraw AE 7.70
WFL 10.04a with Reactive Testbench Generation
ModelSim AE 6.1b
Synplify Pro AE 8.5f (No Gate Limit)
Magma Palace 3.3
Actel Designer 7.2 (No Gate Limit)
FlashPro 4.2
ChainBuilder 1.1
Silicon Explorer 5.1

PC Platform
Node-Locked License Tied to Disk-id or Hardware Keys

Price:  
$2495 First Year / $1995 Renewal
Free 45 day Evaluation License

 World Class Fully Integrated PC Development System
Tool Features

Integrated Design Management a
Schematic a
VHDL  a

Verilog  a
Macro Generation a
Testbench Generator a
VHDL Simulation                              
Verilog Simulation a
Timing Simulation a
Static Timing Analysis a
Timing Driven Place and Route a
Push Button Place and Route a
Layout Editor a
Silicon Explorer a
Standard Industry Interfaces a

Third Party Design Libraries a

Platform Support
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Libero IDE
Solaris and Linux Support

Libero Solaris, Libero Linux
Tools

Project Manager
Synplify AE
ModelSim AE VHDL & Verilog
PALACE AE
SmartGen
Designer

Supports All Devices
Solaris, Linux OS
License Type: Floating

Solaris: Host ID only
Linux: requires USB key for Synplify 

1 Year License: $4995
Incremental seats: $3500

Free 45 day Evaluation License
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Libero Edition Summary

Libero Gold
Libero Platinum 

(Windows)
Libero Platinum 
(Solaris / Linux) Libero Platinum Eval

Device Support
All devices up to 

1M Gates All Devices All Devices All Devices
ViewDraw AE AE - AE

WaveFormer Lite AE
Reactive 

Testbench - Reactive Testbench
Synthesis Synplify AE Synplify Pro AE Synplify Pro AE Synplify Pro AE
Magma Palace - Yes Yes Yes
ModelSim AE AE AE AE
Designer Yes Yes Yes Yes
FlashPro Yes Yes - No
Explorer Yes Yes - No

License Type Disk ID Key or Disk ID Floating

Disk ID (Windows)   
Floating (Solaris / 

Linux)
Price Free $2,495 $4,995 Free 45 day



Libero Installation
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Libero Installation
Select Edition

Installation Wizard Makes 
Installation Easy!

Select Appropriate Product from 
Libero Installation GUI

Platinum or Evaluation
Gold

Request License when Installation 
Finishes
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Libero Installation
Component Selection

Select Design Components and 
Simulation Libraries to Install

VHDL and Verilog Simulation 
Libraries Contained on CD

RECOMMENDATION: Only 
Install Needed Actel Family 
Libraries to Save Disk 
Space
Save Libero CD to Install 
Additional Actel Family 
Libraries for Future Designs

Select components for installation

Select Actel simulation libraries
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Final Installation Page
Upon Installation Completion, User is Asked “Do you 
have a current license installed”?

If No (Default), Takes User Directly to Registration Web Site
Completing Registration or Clicking Off Browser Returns User 
to Final Install/Restart Page
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Installation Summary
Confirm Setup after Installation

Start > Programs > Libero IDE 
v7.2 >  About Your Installation

Includes Information Needed to Get 
License

Tools installed

Simulation 
libraries installed

Synplicity hostID

PC disk serial 
number
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Obtaining a Libero License

Request a Libero License via any of the Following Methods:
http://www.actel.com/products/tools/sw.aspx

Libero License Sent via E-mail within 1 hour!
Libero License Includes Synplicity License

Click to request 
Libero Platinum 
License

Click to request 
Libero Gold License

Enter Software Id
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Libero Gold and Platinum Licenses
Libero Gold License Is Node-Locked to PC Disk ID

Libero Platinum License Requires Software ID

Platinum License Types:
Locked to Disk ID
Hardware Keys

One Key for Synplicity and One Key for All Remaining Software
Parallel Port or USB Options

Software ID

L007-3194-7006
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Libero Platinum Evaluation License

Libero Platinum Evaluation License Contains All Platinum Features 
Except Programming

Click to request 
Libero Eval License

Specify Floating or 
Node-Locked
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Libero Platinum Evaluation License (cont.)
Evaluation License Is Node-Locked to Disk ID

Available from “About Your Installation”

Enter Disk Id

Specify OS
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Libero Licensing Summary

Libero Gold License
Free!
Node-Locked to Disk ID

Libero Platinum (Windows) License
Node-Locked or Locked to Hardware Keys

Libero Platinum (Solaris or Linux) License
Floating License Locked to Host Id

Linux Requires Hardware Key for Synplify

Libero Evaluation License
Node-Locked or Floating
Free 45 day License

Synplicity License is included with Libero License
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License File:
Saving and Setting Variables

Store license.dat File in c:\flexlm 
Folder:

Set Variables
Windows NT

Control Panel -> System -> 
Environment Tab

Windows 2000
Control Panel -> System -> Advanced -
> Environment Vars -> New

Windows XP
Control Panel -> System -> Advanced -
> Environment Variables -> New

Set LM_LICENSE_FILE to 
c:\flexlm\license.dat
Set SYNPLICITY_LICENSE_FILE to 
c:\flexlm\license.dat
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license.dat file
PACKAGE AEALL1 actlmgrd 1999.400 COMPONENTS="Viewdraw Actel \

ActelACT-1Library ActelACT-2Library ActelACT-3Library Generic \
GenericCAE EDIF_NetlistWriter ViewgenSchematicGenerator \
Export1076 EDIF_NetlistReader GRAFLIB VERILNET ViewBASE WDIRDB \
Altran Attdump Attmerge Attupdat Mega ViewGraf PARTSLIST" \
SIGN=B56ED128C7D0

INCREMENT AEALL1 actlmgrd 1999.400 05-dec-2006 uncounted \
VENDOR_STRING="Platform:NT exclusive:35" \
HOSTID=DISK_SERIAL_NUM=a074afe9 ck=5 SIGN=4D2ACA78658C

FEATURE ACTEL_SUMMIT actlmgrd 6.3 05-dec-2006 uncounted \
HOSTID=DISK_SERIAL_NUM=a074afe9 ck=172 SIGN=6E48D3D8E1709AA6

FEATURE wflite syncad 10.0 05-dec-2006 uncounted CD826B8A5F9D \
HOSTID=DISK_SERIAL_NUM=a074afe9 ck=157

FEATURE reactiveexport syncad 10.0 05-dec-2006 uncounted 5C6721A3F2E0 \
HOSTID=DISK_SERIAL_NUM=a074afe9 ck=137

FEATURE basicvcdimport syncad 10.0 05-dec-2006 uncounted A1235A1BD49C \
HOSTID=DISK_SERIAL_NUM=a074afe9 ck=130

FEATURE actelmtivlog mtioemd 2006.12 05-dec-2006 uncounted \
489D4A494DAD HOSTID=DISK_SERIAL_NUM=a074afe9

FEATURE actelmtivhdl mtioemd 2006.12 05-dec-2006 uncounted \
F2AF24411BCC HOSTID=DISK_SERIAL_NUM=a074afe9

FEATURE PALACE_ACTEL_APA_FULL aplus 4.000 05-dec-2006 uncounted \
HOSTID=DISK_SERIAL_NUM=a074afe9 SIGN="03E4 2A9A FCDD 2AF7 D28E \
31C3 229F 5481 924C C09D 6700 B368 0F71 CB42 D6C8 D52D 1C20 \
65E4 4455 7A42 0137"

FEATURE synplify_pc synplctyd 2005.132 05-dec-2006 uncounted \
1D43F615A72D9E5CBDCA VENDOR_STRING=actel_oem \
HOSTID=DISK_SERIAL_NUM=a074afe9 \
NOTICE=CUSTID=QASNT2155712607150 SIGN="0034 46A7 A572 1BE2 \
313B 817D 6EA4 DB9F 8940 9188 9303 7D3D 10C5 B367 5E6E 03BA \
3504 5FFB 4979 7381 6046"

# Your Software ID is : 14D-B05C-33D  #

Synplicity 
License

Expiration date
Software id

ModelSim 
VHDL and 
Verilog 



Libero Project Manager
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Libero Project Manager Features
Centrally Manages and Integrates Files and Tools

Coordinates Project Information between Tools
e.g., Family Is Selected Once and Communicated to All Tools 

Provides Seamless Piping of Internal Design Files among 
Tools
From within Libero’s Project Manager, User Can Invoke 
Tools for:

Design Entry
Stimulus Generation
Simulation
Synthesis
Design Implementation and Static Timing Analysis
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Libero IDE Project Manager

Design
Explorer
Window

Design Explorer Window
Design Hierarchy Tab Displays 
Hierarchical Representation of 
Source Files in Project

Libero Continuously Analyzes and 
Updates Hierarchy
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Design Explorer Window
Design Hierarchy Tab Displays 
Hierarchical Representation of 
Source Files in Project

Libero Continuously Analyzes and 
Updates Hierarchy

File Manager Tab Displays All 
Files in Project Grouped by Type

Libero IDE Project Manager

Libero 7.2 File Manager tab 
supports CoreMP7 and Fusion 
Designs
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Design Explorer Window
Design Hierarchy Tab Displays 
Hierarchical Representation of 
Source Files in Project

Libero Continuously Analyzes and 
Updates Hierarchy

File Manager Tab Displays All 
Files in Project Grouped by Type

Language-Sensitive HDL 
Editor

Verilog 2001 or VHDL 93

Libero IDE Project Manager

HDL pane
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Design Explorer Window
Design Hierarchy Tab Displays 
Hierarchical Representation of 
Source Files in Project

Libero Continuously Analyzes 
and Updates Hierarchy

File Manager Tab Displays All 
Files in Project Grouped by Type

Language-Sensitive HDL 
Editor

Verilog 2001 or VHDL 93

Tools Can Be Launched 
from Design Flow Window or 
Menus

Libero IDE Project Manager

Design
Flow

Window
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Design Explorer Window
Design Hierarchy Tab Displays 
Hierarchical Representation of 
Source Files in Project

Libero Continuously Analyzes 
and Updates Hierarchy

File Manager Tab Displays All 
Files in Project Grouped by Type

Language-Sensitive HDL 
Editor

Verilog 2001 or VHDL 93

Tools Can Be Launched 
from Design Flow Window or 
Menus

Log Windows Provide 
Status and Error Messages

Libero IDE Project Manager

Log Window
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Libero IDE 
Design Flow Window

Design Flow Window 
Displays:

Tools
Files
Transitions
Current State
Tool Tips

Interactive Blocks
Activates Tools
View Files

Display changes 
dynamically based on 
target family
Tabs Switch between 
Flow Window and HDL 
Window

Step-by-Step design flow decreases design development time

Current state of design
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Libero IDE Design Flow Window
File Status of Displayed Items

Group of Files Can Be …

… Missing
If ANY Are Missing, Block Is Shadowed Out

… Available and Current
Green Check Mark Is Shown

… Available, but Not Current
If at Least One is Not Current, Warning Icon Is Displayed

Synthesis 
Complete

Source  Modified –
EDIF Netlist not 
current

Synthesis  
Incomplete
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Libero IDE Design Flow Window
Tool States

Disabled => Button Is Shadowed

White => Available, but Not Yet Used

Green => Completed Successfully

Red => Error in Running Tool

Synthesis 
Succeeded

Synthesis 
Failed
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Libero IDE Design Flow Window
Structural Designs

Design Flow Window Can Be Configured For Structural 
Designs That Do Not Require Synthesis

Un-check if synthesis is not required
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Libero IDE Design Flow Window
Synthesis Not Required

Synthesis button 
disabled
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Libero Log Window Error Manager

Error Manager Consists of 4 Tabs in Log Window:
All: Displays All Messages
Errors: Displays Error Messages
Warnings: Displays Warning Messages
Info: Displays Information Messages

Default Colors:
Red => Errors
Blue => Hyperlinks 
Light Blue => Warnings

Libero error manager tabs

Icon appears next 
to each message

Right
Mouse
Click!

Click in window to 
clear or copy text
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Libero IDE File Menu Options

Create, open, 
close and save 
projects

“Save-As”: Save 
Project with 
Different Name 
and/or in 
Different Location

List of Recent 
Projects
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Importing Files
File -> Import Files 

Existing Design Files Can Be Imported into Libero Project
Schematics, Symbols, HDL (VHDL or Verilog), Stimulus (VHDL or 
Verilog), SmartGen Cores, EDIF Netlists, SDC Files, Constraint Files, 
Tool Profiles

Schematics (*.[1-9]*)
Symbols (*[1-9]*)
Hdl Source Files (*.vhd, *.v, *.h)
SmartGen Cores (*.gen)
CoreConsole Projects (*.ccp)
Stimulus Files (*.vhd, *.vhdl)
Edif Netlists (*.edn)
SDC file (*.sdc)
Physical Design Constraint (.pdc)
Gatefield Constraint files (*.gcf)
VCD Files (*.vcd)
SAIF Files (*.saif)
Simuation Files (.mem, .bfm, .do)
Tool Profiles (*.ini)

Select file type from
pull-down menu
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Import Files
File Manager Tab

Files Can Also Be Imported from File Manager Tab
Click on File Type and Select Import

Right
Mouse
Click!
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Libero IDE File Menu
User Preferences
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Libero IDE User Preferences
Automatic Software Update Check

Enable or Disable Checking for Updates When Libero is 
Launched
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Libero IDE
Checking for Software Updates Manually 

Manually Check for Software Updates from Help Menu
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Libero IDE User Preferences
Project Startup Behavior

Specify How Libero Behaves When Opened
Open with no project or open most recently used project

Default Startup
Most Recent Project Is Opened When Libero is Launched
If None Exists, Libero Launches the New Project Wizard

Default Can be Modified in Libero Startup Properties
Check or Uncheck “Open the most recently used project at startup”
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Libero IDE User Preferences
Log Window Colors

Specify Colors for Messages in the Libero Log Window
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Libero IDE User Preferences
Text Editor

Text Editor Selection
Use Libero IDE Text Editor or 
External Text Editor

File > Preferences  Text Editor 
Tab

Enter location of 
external text editor 
if selected
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Libero IDE
Edit Menu Options
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Libero Project Manager
Find Module / Entity

To find Module in a Hierarchy, click Find Module Icon on 
Tool bar, or Click Edit/Find Module

“Find Next” in Design Hierarchy
From the “Find Module” dialog you can select “Find Next”

Find by using regular expression e.g. *_cntrl => “mode_cntrl”
Find by matching exact case

Libero selects and 
displays the found module
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Libero Project Manager
Find in Files

Edit => Find in Files, or Toolbar 
Icons

Search for Files, Words, etc
Specify by File Types
Specify where to Search
Match Whole Word
Match Case
Regular Expression

Results Shown in “Find in Files”
Tab in Log Window
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Find in Files
Cross Probing

Selecting File Name Presented in Find in Files Log Window …
… Opens Selected File in Libero Text Editor
… Highlights Match
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Libero IDE View Options
Displayed Windows Turned On or Off Using Libero “View” Menu
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Libero IDE Options Menu



© 2006 Actel Confidential and Proprietary 49September, 2006Introduction to Libero v7.2.2

Libero IDE Project Settings
Device - change FPGA die or package

Family cannot be changed
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Libero IDE Project Settings
Device - change FPGA die or package

Family cannot be changed

Simulation –
specify simulation options

“Compile VHDL Package Files”
option is on by default
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Libero IDE Project Settings
Device - change FPGA die or package

Family cannot be changed

Simulation –
specify simulation options

“Compile VHDL Package Files”
option is on by default

Programming – specify location of                                            
programming file and software
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OEM Tools Support
Tool Profiles

Create or Edit Tool Profile for Project
Options > Profiles
Select Third-Party Tools & Versions

Synthesis
Vendor (e.g. Synplify)

Version
Physical Synthesis

PALACE
Version

Simulation
ModelSim

Select Version
Testbench Generation

WaveFormer Lite
Select Version

Name Profile and Save
Edit or Add Profiles As Needed
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OEM Tools Support 
Tool Versions

Tool Profiles
Now Automatically Finds Versions of Installed Tools

Export/import Profiles 
Allows saving & moving profiles to another project
Setting up a new project allows import from another project
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Add / Edit Tool Profiles
Add/Edit Profile Requires

… Name of Profile
… Choosing Tool

From Drop-down Menu
Choose Version

… Choosing Tool Location
Browse for Location
Specify Location
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Profile Conflict
Occurs when Current Profile 
Settings Are Different from 
those of Previous Project that is 
Opened

May Have Newer Version 
Selected when Opening 
Project Created with an 
Older Version
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Libero IDE Files Organization
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Package Files 
Compile Order

Package Files Displayed on Libero 
IDE File Manager Tab

VHDL Packages
Verilog Include Files

Use Package Files Order Window 
to Indicate if Packages Are for 
Simulation, Synthesis or Both and 
to Set Compile Order

Use Up or Down Arrows to 
Change Compile Order 
Check Boxes to Compile 
Packages for Simulation, 
Synthesis, or Both

Select Options => Package Files 
Organization, or Right Click in 
Design Hierarchy Window
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Libero Project Manager
Designer Constraint Files

User Can Specify Constraint Files To Send To Designer
Timing Constraints (.sdc) or Physical Constraints (.pdc)

Files may come from Synthesis or PALACE or be generated 
by the engineer

Constraint 
files in project

Constraint files 
sent to 
Designer

Specify order which 
files are imported
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Libero Project Manager
Stimulus Files

Libero Allows Users to Specify List of Stimulus Files for 
Simulation

No Stimulus File Selected by Default
Libero Remembers Stimulus Association for Any Block



© 2006 Actel Confidential and Proprietary 60September, 2006Introduction to Libero v7.2.2

Hierarchical Testbench Support 
Libero Supports Hierarchical Testbenches

Select Multiple Files 
Libero does not automatically determine compile 
dependencies of stimulus files
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Libero IDE
Designer Views Menu
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Libero Project Manager 
Design Implementations

Create Project Variations
Save Different Project Views for Comparison
Requires .adb file, Back-annotated File, 
Programming/Debugging File, or Post-layout Simulation 
Folder
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Libero Project Manager
Design Implementations

Add, Rename or remove design implementations
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Libero Project Manager
Design Implementations

Implementations
Making Changes in Current View Can Change State of 
Project

Pre-Synthesis
Post-Synthesis
Post-Physical Synthesis 
Affects All Other Views 

Changing Implementation Files for Current View Does Not 
Affect Other Views



© 2006 Actel Confidential and Proprietary 65September, 2006Introduction to Libero v7.2.2

Libero IDE New Project Wizard
Menu-Driven Wizard

File > New Project

Status Guide Shows Current 
State

All Fields Must Be Filled in to 
Continue

HDL Type Must Be Consistent 
with License

Next Button Goes to Next 
Wizard Screen

Finish Button Finishes/Closes 
Wizard after Making Changes. 
Saves All Selections.

Use Browse button to change 
project location
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Libero IDE New Project Wizard
Select Device

Select Family

After Family Is Selected, 
Devices from that Family Are 
Displayed

After Device Is Selected, 
Available Packages for that 
Device Are Displayed
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Libero IDE New Project Wizard
Select Tools

Synthesis
Vendor (e.g. Synplify)

Version

Physical Synthesis
PALACE

Version

Testbench Generation
WaveFormer Lite

Select Version

Simulation
ModelSim

Select Version

Support for Mentor Graphic’s 
LeonardoSpectrum and 
Precision

Standard Tools Direct from 
Mentor

No Actel OEM Versions
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Libero IDE New Project Wizard
Add Files

Add Existing Design Files to Project
Schematics, Symbols, HDL (VHDL or Verilog), Stimulus 
(VHDL or Verilog), SmartGen Macros or EDIF Netlists

Select file type

Browse to file location
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Libero IDE New Project Wizard
Finish

Project Information Listed in Dialog Box
Click “Finish” to Complete Project Creation or “Back” to 
Make Corrections or Additions

Project summary 
shown in window
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Libero project file

Default folder for
Libero projects

Organization of Libero Project Files
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Design Hierarchy Tab
Block Properties

Block Properties Dialog Box Displays File Path, Date 
Created and Last Modified Date

Right
Mouse
Click!
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Libero Project Manager 
Include Modules for Simulation

Libero Only Passes Top-level Source-related Modules to 
Simulation

If Other Source Modules Are Required for Simulation, 
Check Box on File Properties

Check to include file in 
simulation
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Unknown Hierarchy
Libero Displays Files in “Default 
Configuration” Tree

Missing Files Indicated with “?”

When Libero Cannot Determine 
Hierarchy, Files Are Shown with “X”
under Unknown Hierarchy on Design 
Hierarchy Tab

Files also Shown with “X” on File 
Manager Tab
Examine these Files to Correct 
Problem or Remove File from Project
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Deleting Files from Libero Project
Files Can Be Deleted from Project and from HDD

Files Deleted from HDD Cannot Be Recovered!

Right
Mouse
Click!
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HTML-based Help System
Help Available for Error Messages, 
Specific Screens and Menus
Expanded Content

Hyperlinks to Application Notes 
and Actel Web Pages
Help Menu Provides Direct Access 
to All Libero PDF Reference 
Manuals

Libero IDE Online Help



Design Entry
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Design Entry
Libero Supported Design Flows

Structural Schematic Flow
Mixed-Mode Flow 
HDL Flow 

SmartGen Macro Builder

ViewDraw Overview
Schematic Design Entry Tool



Libero Design Flows
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Libero Design Flows
Structural Schematic Flow

Contains only Actel ViewDraw Library Components or Mix 
of Actel ViewDraw Library Components and Structural HDL
Top Level Must Be Schematic!
Synthesis Optional before Layout

Mixed-Mode Flow
Schematic and RTL Blocks

May also Contain Structural HDL Blocks
Top Level Must Be Schematic!
Synthesis Required before Layout

HDL Flow
VHDL or Verilog (not both)
May Contain Structural Blocks



SmartGen Macro Builder
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SmartGen Macro Builder
Create Macro 
Functions from User’s 
Parameters 

Optimized for Actel 
Architecture

High Speed 
Small Area

Rule-based Generation 
Guarantees Functional 
Accuracy

Outputs:
VHDL - Behavioral 
and Structural
Verilog - Behavioral 
and Structural
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Using SmartGen within Libero
SmartGen Macros Can Be Used in …

… Structural Schematic flow
… Mixed-mode Flow
… HDL Flow

Steps:
Launch SmartGen from Libero IDE Project Manager
Create HDL Structural Implementation

VHDL or Verilog
HDL Flow

Instantiate Macro in Top-level RTL
Structural Schematic and Mixed-mode Flows

Create ViewDraw Symbol from Libero
instantiate Symbol in Schematic
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SmartGen icon

Launching SmartGen from Libero
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SmartGen User Interface

Core
details

Shows Categories
Based on Selected
Family

View by category
or alphabetically Version #

Version of selected or 
configured core

View selected and 
configured cores 
for project

View Actel IP Catalog
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SmartGen
Counter Example

2.  Select type 
and variation

1.   Choose
Function
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SmartGen
Counter Example

4.  Complete the
rest of the
description

3.  Enter width

5.   Click Generate

Optional Fan-In 
Control
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SmartGen Buffering Control

Users Can Control Buffering in 
SmartGen Macros

Control Net Loading or 
Eliminate Buffering
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SmartGen Component Generation

Files appear on 
Libero File Manager 
tab

Generate 
behavioral VHDL 
or Verilog

Core 
name
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SmartGen RAM Initialization
Speeds up simulation time 
by reducing the initial writes 
to setup the memory

Completely automated 
simulation flow

MEMORYFILE property 
preserved throughout the 
flow

Cascading of multiple RAM 
blocks handled automatically

Supports industry standard 
memory content specification 
files

SmartGen

Memory Content 
Manager .mem

RAM 
netlist

Simulation

Synthesis
Post-Synthesis 

Designer
Backannotation

BA _RAM 
netlist

.hex /. s 
memory 

file

Pre-Synthesis 
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SmartGen RAM Initialization (cont.)
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Memory Content Manager Features

Variable aspect ratio support
Read View & Write View 

Import of User Memory File
Intel hex format
Motorola- S format

Multiple Radix for data and 
address display

Hex
Bin
Decimal



Structural Schematic Designs
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Structural Schematic Design Flow

Programming

Place & Route

Post-P&R Simulation

Pre-Layout
Simulation

Design Capture

Generate 
Structural Netlist
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Design Capture

Programming

Place & Route

Post-P&R Simulation

Pre-Layout
Simulation

Design Capture

Generate 
Structural Netlist



ViewDraw Overview

Schematic Design Entry Tool
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ViewDraw
Features

Powerful Editing Capabilities 
Simple, Push-Button GUI Enables Rapid Design Input 
Infinite Undo/Redo
Dynamic Pan and Autoscroll
Automatic Connection of Abutting Pins
Rubber Banding of Connected Nets with Dynamic Redraw

Flexible and Customizable
Designers can Add, Delete, or Reorder Items in Menu 
System
Commands Can Also Be Entered via Function Keys or CLI
Selectable Display Styles for Lines, Fill Patterns, Bus 
Widths
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ViewDraw
Additional Features

ViewDraw AE can read 
EPD 2.0 and 3.0 

Generated schematics 
Schematic files
Outputs in ViewDraw format

ViewDraw can co-exist/co-install with ePD
Customers can switch back and forth between ViewDraw 
and ePD tools
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Launch ViewDraw from Libero.

Create Schematic

Save and Check

Invoking ViewDraw

Double
Click!

Enter schematic name
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ViewDraw

Zoom
Functions

Push 
symbol 

or 
schematic

Net 
and Bus
Connection

Drawing
Tools

Save+Check

Insert
Component

Command 
Window
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Inserting ViewDraw Components
Add -> Component

Select Directory
• Project directory
•Actel cells
•ViewDraw builtin

Component appears here
•Drag and drop into 
schematic

Enter component name
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Built-in Library Contains Several Sheet Border 
Templates

Templates Can Be Modified

Adding Schematic Border

Select built-in library

Enter sheet name (asheet, bsheet, etc.)

Drag and drop
into schematic
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ViewDraw Border in Schematic
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Customizing a Schematic Border
Border Template Can Be Customized

Open Border (File > Open)
Select Symbol from “Type” Menu

Select built-in library

Select Symbol



© 2006 Actel Confidential and Proprietary 104September, 2006Introduction to Libero v7.2.2

Select project library

Select Symbol

Enter new sheet name

Customizing a Schematic Border (cont.)
Save File to New Name

(File > Save Copy As <name>)
Border Saved in Project Library

Visible on Libero File Manager Tab
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Customizing a Schematic Border (cont.)
Open Saved Border and Edit (File > Open)

Add Lines, Arcs, Text, etc. as Necessary

Modified border visible 
on File Manager tab
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Select cell library

Enter cell name

Drag and drop
into schematic

Adding Schematic Components
Add > Component from ViewDraw Menu

Add SmartGen Macros, Custom Macros or Actel Basic Cells
Select VCC or GND from ‘actelcells’
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Drawing Wires and Busses
Adding a Net

To Add Net:
Choose Add > Net (or Add > Bus)

Alternate: Click Wire (    ) or Bus (    ) Icon on Toolbar
Specify Net Origination Point and Depress Left Mouse Button
Drag Mouse to Form Net (or Bus), specifying Points along Net 
by Clicking Right Mouse Button 
Click Right Mouse Button to Insert Vertex in Net
Release Left Mouse Button to Specify Ending Point for Net
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Adding I/O Cells

Add I/O Cells to Top-level Design Schematic
Schematic-only Designs or Structural Schematic Designs
Macros Contained in “actelcells” Component Library

I/O Cells Must Have Dangling Hierarchical Connector 
Attached to Pad Side

Label Dangling Connector

I/O Macros Can Be Buried in Hierarchy

Add and label 
this net

Add and label 
this net

Add and label 
this net
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Use Hierarchical Connectors from ViewDraw Built-in 
Library for All Designs

Add just like Any Other Component
Same Connector for Wire or Bus 
Called ‘in’, ‘out’, or ‘bi’ in Built-in Library

Label Net or Bus Next to Connector

Hierarchical Connectors 

add label to net add label to bus add label to net
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ViewDraw Attributes
A Limited Number of Attributes Can Be Entered into 
Schematic and Passed to Designer

$Array Attribute
Creates Arrays of Cells in Schematic

Useful for I/O Buffers
Double-click Cell, Enter on Attribute Tab
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At Design Entry Completion , Save 
and Check Design

Click Save Check Icon 
Use Tools > Schematic Checker

Design Rule Checking

Viewdraw Status Bar:
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Design Entry Completion
Files in Implementation Are Displayed on Libero Design 
Hierarchy and File Manager Tabs

Schematic
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ViewDraw File Structure on HDD
Schematic Files Saved in “sch” Folder

Symbol Files Saved in “sym” Folder

Wire Files Saved in “wir” Folder

Files Visible on Libero File Manager Tab
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Opening Existing Schematics

Right
Mouse
Click!
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Completed Schematic

Input buffers Output bufferActel library components
Hierarchical

connectors

Hierarchical

connector
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Libero Schematic Checker (Optional)

Schematic Connectivity Checker in Libero
Checks for Errors Not Included in ViewDraw Save + Check
Optional Step Available from File Manager Tab

Right
Mouse
Click!
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Structural Schematic Flow
Using SmartGen Macros

Launch SmartGen from Libero Project Manager
Create HDL Structural Implementation

VHDL or Verilog
Create ViewDraw Symbol from Libero and Instantiate Symbol in 
Schematic

Symbol Visible on File Manager Tab

Right
Mouse
Click!

Symbol



Mixed-Mode Designs
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Mixed-Mode Design Flow

Place & Route

Synthesis

Programming

Simulation Post-Synthesis Simulation

Post-P&R Simulation

Design Capture
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Design Capture

Place & Route

Synthesis

Programming

Simulation Post-Synthesis Simulation

Post-P&R Simulation

Design Capture
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Mixed Mode Design Entry

Mixed Mode => RTL Blocks within Schematic
HDL Blocks Can Be Structural or Behavioral RTL

RTL Blocks Can Be VHDL or Verilog (But Not Both)
Top Level Must Be Schematic

Procedure
Create HDL Blocks

RTL Blocks - Use HDL Editor or Import Existing Design Files
Structural Blocks - Use HDL Editor or SmartGen

Create ViewDraw Symbols for HDL Blocks
Done Automatically from Libero Design Flow Manager

Instantiate Blocks in Schematics and Make Interconnects
Use Hierarchical Connectors from ViewDraw “built-in” Library for 
HDL Ports in Schematic
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RTL in Mixed-Mode Flow
Create RTL from Libero HDL Editor or Import File

OR
Create HDL Structural Implementation using SmartGen

VHDL or Verilog
Create ViewDraw Symbol from Libero Instantiate Symbol in 
Schematic

Symbol Appears on File Manager Tab

Right
Mouse
Click!

Symbol
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Mixed Mode Schematic
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Synthesize
Optional for Pure Schematic or 
Structural Schematic Flows

All HDL Blocks Are 
Structural VHDL or Verilog 
(e.g., SmartGen Blocks)

Required for Mixed-mode 
Designs

Designs Containing RTL  
Blocks

Libero Launches Synplicity to 
Insert Pads and Optimize 
Design

Hierarchical Connectors 
Must Be Used
Structural Schematics with 
All Pads Instantiated Can Go 
Directly to Designer Tool

Synthesize



HDL Designs
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HDL Design Flow

Place & Route

Synthesis

Programming

Simulation Post-Synthesis Simulation

Post-P&R Simulation

Design Capture
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Design Capture

Post-Synthesis Simulation

Post-P&R Simulation

Synthesis

Place & Route

Programming

Simulation

Design Capture
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Creating New HDL Macros
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HDL Editor
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HDL Editor
Block Comments

Comment Command Allows Users to Comment Sections of 
VHDL or Verilog Code
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HDL Editor
Block Comments

Comment Command Allows Users to Comment Sections of 
VHDL or Verilog Code
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HDL Editor
Block Comments

Comment Command Allows Users to Comment Sections of 
VHDL or Verilog Code
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HDL Editor
Block Comments

Uncomment Command Allows Users to Uncomment Sections 
of VHDL or Verilog Code
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HDL Editor
Block Comments

Uncomment Command Allows Users to Uncomment Sections 
of VHDL or Verilog Code
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HDL Editor
Detect Changes

If File Is Open in Libero HDL Editor and Modified by 
another Text Editor, Warning Is Issued

Warning 
message in 
Libero
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Libero HDL Syntax Checker
HDL Syntax Checker Available from File Manager Tab 

Checks for Errors in HDL Blocks
Errors Indicated in Libero Log Window
Optional Step

Right
Mouse
Click!
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Project Manager with Saved Files...

VHDL files
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Functional Simulation

Simulation Post-Synthesis Simulation

Post-P&R Simulation

Design Capture

Synthesis

Place & Route

Programming
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Simulation Flow
For Each Block You Want to Simulate . . .

Export Testbench

Invoke simulator  

Compile and Run 
the simulation 

Generate stimulus   View Waveforms

Associate Stimulus  
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Invoking WaveFormer Lite

Double
Click!
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WaveFormer Lite Features

Allows Convenient Test Stimulus Specification via GUI
User Specifies Stimulus by Drawing Waveforms

Supports Copy / Paste / Append Operations
Significantly Reduces Testbench Creation Time 
Automatically Converts Graphical Stimulus Files into HDL 
TestBenches
Can Generate:

VHDL Testbench (*.vhd) 
Verilog Testbench (*.v)

Users Can Annotate Waveform For Design Documentation
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Signal level controls Zoom controls

Bus value controls

Drawing Stimulus
WaveFormer Lite Diagram Window

inputs

Cursor
location
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Creating Clocks

Right
Mouse
Click!
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Creating Clocks

Click!
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Creating Clocks

Double
Click!
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Creating Clocks

Click!
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Creating Clocks

Clock 
frequency

Clock name

Clock 
duty     
cycle

Start high
or low
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Creating Clocks

Click!
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Creating Clocks

Click!
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Creating Clocks
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Drawing Signals

Align curser and click!
Use zoom controls to make viewing easier

State button toggles automatically
Select “low” state button
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Drawing Signals
Edge Placement

Double click at end of signalEnter time for edge placement
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Editing Signals
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Drawing Busses

Double click “VAL” state button
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Drawing Busses

Button will stay in  “VAL” state
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Drawing Busses
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Drawing Busses
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Drawing Busses

Double
Click!
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Drawing Busses
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Drawing Busses

Click!
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Drawing Busses
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Drawing Busses

Click!
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Drawing Busses
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Editing Signals
Appending and Inserting
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Editing Signals
Appending and Inserting
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Editing Signals
Appending and Inserting
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Editing Signals
Appending and Inserting
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Editing Signals
Appending and Inserting
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Editing Signals
Appending and Inserting
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Copying to a Different Signal
Signal Can Be Copied
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Signal Can Be Copied

Copying to a Different Signal
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Signal Can Be Copied

Copying to a Different Signal
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Signal Can Be Copied

Copying to a Different Signal
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Signal Can Be Copied

Copying to a Different Signal
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Signal Can Be Copied

Copying to a Different Signal
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Signal Can Be Copied

Copying to a Different Signal
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Signal Can Be Copied

Copying to a Different Signal
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Reactive Test Bench:
Stimulus and Expected Response

Draw stimulus waveforms on the input ports of the 
model under test.

Draw expected response waveforms on the output ports 
of the model under test
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Reactive Test Bench:
Samples

Samples Verify MUT Output 
Sample constructs can monitor and perform actions based on 
the data sampled
Sample can work at a single point or over a windowed area  
Sample can perform relative to the beginning of the 
transaction or relative to another event in the diagram.
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Reactive Test Bench:
Control & Looping

Markers used for Control & Looping Sections of 
Transactions

Specify the end of the transaction
Create loops using for, while, and repeat loop markers
Insert HDL code
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Reactive Test Bench:
Variables

Variables Parameterize State Values 
Variables can drive values on stimulus waveforms
Variables can store values on expected waveforms 
Waveform states can be expressed as conditional 
expressions using variables 
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Reactive Test Bench:
Delays

Delays Parameterize Time Values 
Delays represent the time between two edges in the 
diagram

Specify min and max values
Delay values can be time or cycle-based
Conditionally control when edges occur
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Reactive Test Bench:
Help Resources

Online Manual: 
Choose Reactive Test Bench Generation Under the Help menu

PDF Manual:
Reactive_testbench_Generation_Option.pdf under the Help 
folder in the SynaptiCAD install directory

SynaptiCAD’s website: www.syncad.com
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Saving Stimulus
Save Stimulus
File > Save

File Name May Contain Name of Top-level Module
Stimulus Appears on Libero File Manager Tab
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Generating the Testbench
Select Export from WaveFormer Lite Menu

WaveFormer Lite Has Many Export Options
Recommendations

VHDL Testbench - Select “VHDL with Top Level Testbench”
Verilog Testbench - Select “Verilog with Top Level Testbench”
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Waveform and Testbench

stimulus
testbench

Stimulus and testbench 
appear on File Manager 
tab in Libero
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ModelSim AE
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ModelSim AE, PE, LE, & SE 
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ModelSim AE
Same Functionality as ModelSim PE

Win NT, Win 2000 or Win XP
Node-Locked

VHDL or Verilog

Reduced Performance

No Co-simulation (VHDL and Verilog) Capability

Limited to Simulation of  Actel’s Gate-level Libraries

Supported through Actel
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ModelSim Default Window Layout
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ModelSim Dockable Windows
Windows Within The Main Window Are Dockable

Move The “Drag Handle” To The Desired Location

Additional Window Features
Drag & Drop

HDL Items Can Be Dragged from Dataflow, List, Signals, 
Source, Structure, Variables, and Wave Windows …
… And Dropped into either List or Wave Window

Automatic Window Updating
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ModelSim Main Window
Menu Bar

Status Bar (current time, 
delta time step, environment)

TCL Interpreter
ModelSim> prompt before design is loaded.
VSIM> prompt is displayed after design is loaded

Tool Bar (Break, Run, 
Cont, Step, and Step Over)

Design 
Hierarchy
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Workspace Window
Workspace provides access to:

Libraries
Compiled Design Units
Design Source Files
Memory Modules
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Objects Window
Shows Names and Values of HDL Items in Current Region 
Selected in the Workspace

Objects include signals, nets, registers, constants and variables 
not declared in a process, generics and parameters

Items Can Be Sorted in Ascending, Descending or Declaration 
Order

Hierarchy (+) Expandable
VHDL Items - Signals
Verilog Items - Nets, Register Variables
Named Events

“Drag & Drop”
Wave & List windows

Force Apply Stimulus
Filter Signal Types (input,output etc)
Find HDL Items
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Source Window
Can Be Un-docked From The MDI Pane Of The Main 
Window

Color-coded Comments, Keywords, Strings, Numbers, 
Executable Lines, Identifiers, System Tasks, Text

Full Edit Capability
Save, Compile and Restart

Drag and Drop

Describe

Examine
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Wave Window

Multiple PanesDrag & Drop
Multiple Cursors

Zooming

Cursor 
MeasurementsSimulation Control Item formatting

Virtuals
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Creating Busses in Wave Window
Scalar Signals Can Be Combined into Vectors
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Saving Wave Data
Signals Added to Wave Window Can Be Saved for 
Future Simulation Runs

File > Save from Wave Window

Enter file name
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Locals Pane
Displays Data Objects That Are Immediately Visible 
From The Statement That Will Be Executed Next

Contents Of The Window Change From One Statement 
To The Next
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DataFlow  Window
Explore physical connectivity of design

Displays processes, signals,  
nets and registers
Links to Main, Process, 
Signals, Wave and Source 
windows

Find feature allows searching for 
signal, net or register names
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Dataflow Window
ModelSim AE Simulator

The ModelSim AE simulator has a limited Dataflow 
functionality

Only one process and it’s attached signals or one signal 
and it’s attached processes are displayed

Zoom
control

Display net drivers 
or readers
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List Window
Simulation Results in Tabular 
Format

VHDL - Signals and Process 
Variables
Verilog - Nets and Registers

“Drag & Drop”

Find Function

Trigger / Strobe Properties

Write List
Tabular
Event
TSSI

Markers - Add, Delete or Goto
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Saving Tabular Output
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Saving Tabular Output
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Saving Tabular Output
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Saving Tabular Output
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Advancing Simulation Time
Three Methods

At VSIM prompt:
VSIM 12> run 100 ms
In Main Window Tool Bar:

In Wave Window Tool Bar: 
Run Length       Continue Run     Break        Step Over

Run      Run -all

Continue Run       Break

Restart                            Run      Run -all     Step  
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Re-starting Simulation 
Restart to Zero

Force Restart at VSIM Prompt
VSIM 12> restart –f

In Main Window Run > Restart or Restart Button
Displays Restart Dialog

Keep Current
Listed Signals
Waved Signals
Breakpoints
Logged Signals
Virtual Signals
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ModelSim Macro Files
ModelSim Commands Can Be Saved in Macro File

The ‘do’ Command Executes Commands 
Macro File Can Have any Name and Extension

Syntax:
do<filename> [<parameter_value>]

Example:
do run.do

This Command Executes File run.do

vlib presynth
vmap presynth ./presynth
vcom -93 -work presynth D:/Actelprj/count32/hdl/count32.vhd
vcom -93 -work presynth D:/Actelprj/count32/stimulus/count32.vhd
vsim presynth.testbench
add wave /testbench/*
run 1000ns
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Libero Simulation Options
Simulation Options Can Be Set from Simulation Tab under 
Options

Results Saved in run.do File

Include Do file allows Libero to 
include user-defined script.  User 
can enter name of script file

Specify simulation run time

Select min, typ, max 
simulation conditions for post-layout 
simulation

Default resolution based on family 
choice

1ps for 500K, APA, 54SXA, AX
1ns for all other families

Use Automatic Do File allows 
Libero to automatically set up 
the simulation for the user
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Invoking ModelSim
Pre- or Post-Synthesis

Click “Simulation” Design Flow Window or …

Right
Mouse
Click!

Double
Click!
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Associating Stimulus

Right
Mouse
Click!
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Pre-Synthesis Simulation
ModelSim Automatically 
Compiles Design and Runs 
Simulation for 1 µS

(External) Signals from 
Testbench Automatically 
Added to Wave Window
Additional (Internal) Signals 
Can Be Added by User
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Simulating Designs
Summary

Capture Design
Generate RTL Netlist (VHDL or Verilog)

OR
Create Schematic

May Include RTL blocks
Structural VHDL or Verilog Netlist 
Automatically Created before Simulation

Create Testbench
Use WaveFormer Lite, or Text Editor

Associate Stimulus

Run Pre-Synthesis Simulation
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Synthesis

Simulation Post-Synthesis Simulation

Post-P&R Simulation

Design Capture

Place & Route

Programming

Synthesis
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Invoking Synplicity
Click “Synthesis” in Design Flow Window or ..

Right
Mouse
Click!

Double
Click!
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Synplify Interface

Global synthesis
constraints

Change target 
and result file

Add constraint files or 
VHDL packages

Libero automatically lists files 
lowest levels first, top last
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Result File 
Synplicity Produces an EDIF Netlist

<design>.edn 

Libero Automatically Produces Structural VHDL or 
Verilog Netlist

<design>.vhd or <design>.v
Results Appear on File Manager Tab under Synthesis Files
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Setting the Target Options

By default, Synplify will 
insert Actel I/O 
macros on all the HDL 
I/O ports.
When synthesizing 
lower-level blocks, this 
must be disabled.

High fanout = slow, small 
designs
Low fanout = fast, large 
designs
Use defaults for first 
pass
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Global Constraints
Frequency

Symbolic FSM Compiler

Configure HDL Compiler

Resource Sharing
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Global Frequency
Global clock frequency is applied to 
all clock domains in the design
Low value means optimize for area
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Symbolic FSM Compiler

When checked, it 
selects proper encoding 
for all state machines.

Encoding method can be set on 
individual state machines with 
syn_encoding directive in the 
HDL code
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State Machine Encoding (VHDL)

Options > Configure VHDL Compiler

Sets the default encoding style for enumerated types

Override encoding style on 
an individual basis using 
syn_encoding directive in 
constraint editor or the 
HDL source code

# of states default encoding
1 - 4 sequential
5 - 24 one-hot
> 24 gray
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B

A

D

C

Y

+

+

S

Without resource sharing With resource sharing

S

+
C

A

D

B
Y

Resource Sharing
When enabled, Synplify 
performs automatic sharing of 
operator resources, including 
adders, subtractors, 
incrementers, and 
decrementers.

if (s = ‘0’) then
Y <= A + B;
else
Y <= C + D;
end if;

if (s = ‘0’) then
Y <= A + B;
else
Y <= C + D;
end if;
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Performing Synthesis

Compile only or check syntax
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View Log

Synplify Log contains Plenty 
of Valuable Information:!

Warnings and Errors
Double-click and Jump to 
Code!

Fanout Limit
Extraction Information 
(Found Counter, FSM, 
Adder, etc.)
Net Loading
Logic Buffering and 
Replication Information
Resource Usage
Critical Path Timing 
Analysis



© 2006 Actel Confidential and Proprietary 228September, 2006Introduction to Libero v7.2.2

Reading the Log File
Errors

Double
Click!



© 2006 Actel Confidential and Proprietary 229September, 2006Introduction to Libero v7.2.2

Constraint Editor

Synplify facilitates constraint 
entry with a spreadsheet-like 
constraint editor.

File->New

Select Constraint File 
(Spreadsheet)
Select Files of type 

Constraint Files

Press OK

Extremely easy to use
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Constraint Editor
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Constraint Editor (Cont.)

Constraint Editor supports a   
Drag and Drop interface. 

There are sheets for entering:
Clock Frequency or  Period
Clock to Clock timing
Input/Output Constraints
Registers Constraints
Multi-Cycle Paths
False Paths
Attributes
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Constraint Editor (Cont.)
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Constraint Editor (Cont.)
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Constraint Editor (Cont.)



Synplicity Directives and Attributes
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Synplicity Directives and Attributes
Let You Direct Analysis, Optimization, and Mapping of 
Design during Synthesis 

Attributes Control Mapping Optimizations
Attributes Can Be Entered in either .sdc Constraint File or 
HDL Source Code

Synplify Supports Limited Number of Attributes that Can Be 
Entered in Attribute Pane of the SCOPE Editor
Most Attributes Are Entered in your VHDL or Verilog Code

Directives Control Compiler Optimizations 
Directives Must Be Entered in HDL Source Code
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alspreserve
Actel-Specific Attribute

Keeps Net from Being Collapsed in Designer (Back-end) 
Tools

Must also Add syn_keep to Ensure Synplicity Retains Net
Synplicity Adds alspreserve Attribute to EDIF Netlist
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alspreserve
Syntax

Verilog Syntax
object /* synthesis alspreserve = 1 */ ;

Example:

VHDL Syntax
attribute alspreserve of object : signal is true ;

Example:

module foo ( in, out);
input [6:0] in;     output out;     wire out;
wire or_out1    /* synthesis syn_keep=1 alspreserve=1 */;
wire and_out1;     wire and_out2;
wire and_out3  /* synthesis syn_keep=1 alspreserve=1 */;

architecture comb of foo is
signal and_out1, and_out2, and_out3, or_out1 : std_logic;

attribute syn_keep of and_out3 : signal is true;
attribute syn_keep of or_out1  : signal is true;
attribute alspreserve: boolean;
attribute alspreserve of and_out3 :signal is true;
attribute alspreserve of or_out1 : signal is true;
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tmr

cc

tmr_cc

syn_radhardlevel
Actel Antifuse FPGA Specific Attribute

Sets Register Model for Module, 
Architecture or Registers

Often Used for Radiation-Hardened 
Designs 

syn_radhardlevel <string value>
cc - Use Combinational Cells to 
Implement Storage Elements
tmr - Use Triple-Module Redundancy to 
Implement Registers
tmr_cc - Use Triple-Module 
Redundancy where Storage Element Is 
Composed of Combinational Cells
none - Use Standard Registers
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syn_radhardlevel
Example (cont.)
SCOPE attribute tab:

Source files:

Add to infer C-module flip-flops

use C-module flip-flop for qA
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syn_encoding
Attribute

Sets Encoding Style for State Machines
Overrides Default Style

Default Style - Compiler Selects Encoding Style Based 
on Number of States as Follows:

1 - 4 States: Sequential
5 - 24 States: One-hot 
> 24 States: Gray 

syn_encoding Can Have the Following Values:
onehot
gray
sequential
safe
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syn_maxfan
Attribute

Controls Maximum Fanout of Instance, Net, or Port

Limit Specified by this Attribute May Be Treated as Hard 
or Soft Depending on Where It Was Specified

Soft Limit May Not Be Honored if it Degrades Performance

You Can Apply syn_maxfan Attribute to Module, 
Register, Instance, Port, or Net 

For ProASIC and APA Designs Only – You Can also Apply to 
Module or Entity  
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syn_maxfan
Usage

SCOPE Constraint Editor Usage

SDC File Syntax
define_attribute { object } syn_maxfan { integer }

Example – Limit Fanout for Signal clk to 200:

. . .
define_attribute {clk} syn_maxfan {200}

. . .
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syn_maxfan
Syntax

Verilog Syntax
object /* synthesis syn_maxfan = "value" */ ;

Example:

VHDL Syntax
attribute syn_maxfan of object : object_type is "value" ;

Example:

module test (registered_data_out, clock, reset, data_in);

output [31:0] registered_data_out;  input clock, reset;

input [31:0] data_in;

input reset /* synthesis syn_maxfan=1000 */;

// Other code

entity test is
port(clock, reset : in bit;

data_in : in bit_vector(31 downto 0);
registered_data_out: out bit_vector(31 downto 0))

attribute syn_maxfan : integer;
attribute syn_maxfan of reset : signal is 1000;
-- Other code
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syn_replicate
Attribute

Prevents Replication of Register
assign syn_replicate = 0 Turns Off Register Replication
Cannot Force Tool to Replicate
Works along with max_fanout Value
Only Supported on Individual Register

When Will Synplify Replicate or Buffer?
Generally Flip-flops Are Replicated to Achieve Fan-out 
Control
For Combinatorial Cells, Buffers Are Added
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syn_replicate
Usage

SCOPE Constraint Editor Usage

SDC File Syntax
define_global_attribute syn_replicate = { 1 | 0 }
Example - Disables All Replication in Design:

1 enables replication
0 disables replication

. . .
define_global_attribute syn_replicate {0}

. . .
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syn_replicate
Usage (cont.)

Verilog Syntax
object /* synthesis syn_replicate = 1 | 0 */;

Example:
module norep (Reset, Clk, Drive, OK, ADPad, IPad, ADOut);

. . .
reg [31:0] IPad;

reg DriveA /* synthesis syn_replicate = 0 */;

assign ADPad = DriveA ? ADOut : 32'bz;

always @(posedge Clk or negedge Reset)

if (!Reset) begin

DriveA <= 0;

IPad   <= 0; end

else        begin

DriveA <= Drive & OK;

IPad   <= ADPad;  end

endmodule

0 disables replication
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syn_replicate
Usage (cont.)

VHDL Syntax
attribute syn_replicate of object : object_type is 

true | false ;

Example:
entity norep is port (

Reset : in std_logic;
Clk : in std_logic;
Drive : in std_logic;
OK : in std_logic;
ADPad : inout std_logic_vector (31 downto 0);
IPad : out std_logic_vector (31 downto 0);
ADOut : in std_logic_vector (31 downto 0));

end norep;
architecture archnorep of norep is
signal DriveA : std_logic;
attribute syn_replicate : boolean;
attribute syn_replicate of DriveA : signal is false;

begin

-- Other code

false disables replication
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syn_sharing
Directive

Enables/Disables Resource Sharing of Operators inside 
Module during Synthesis 

By Default, Directive Is Enabled (Value 1 for Verilog, true for 
VHDL). 
If Resource Sharing Check Box in Project View is Disabled, 
You Can Still Enable Resource Sharing Using syn_sharing
Directive 
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syn_sharing
Usage

Verilog Syntax
object /* synthesis syn_sharing = 1 | 0 */ ;

Example:

VHDL Syntax
attribute syn_sharing of object : object_type is " true | false";

object can be architecture name
Example:

module my_design(out,in,clk_in) /* synthesis syn_sharing=0 */;

// Other code

entity alu is 
port ( a, b : in std_logic_vector (7 downto 0);

. . . );
end alu;
architecture behave of alu is
-- Turn on resource sharing for the architecture.
attribute syn_sharing of behave : architecture is "true";
begin
-- Other code
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syn_noclockbuf
Synthesis Attribute

Selects/Deselects Automatic Clock Buffering
Value of ‘1’ (or Boolean TRUE) Turns OFF Automatic Clock 
Buffering
You Can Apply syn_noclockbuf Attribute to Module, Register, 
Instance, Port, or Net

Synplicity SCOPE Constraint Editor Usage
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syn_noclockbuf
Attribute Usage (cont.)

Verilog Syntax
object /* synthesis syn_noclockbuf = "value" */ ;

Example:

VHDL Syntax
attribute syn_noclockbuf of object : object_type is "value" ;

Example:

module test (registered_data_out, clock, reset, data_in);

output [31:0] registered_data_out;  input clock;

input [31:0] data_in;

input reset /* synthesis syn_noclockbuf=1 */;

// Other code

entity test is
port(clock, reset : in bit;

data_in : in bit_vector(31 downto 0);
registered_data_out: out bit_vector(31 downto 0))

attribute syn_noclockbuf : boolean;
attribute syn_noclockbuf of reset : signal is true;
-- Other code
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syn_insert_buffer
Synthesis Attribute

Directs Synplify To Infer Specific Pads
No Instantiation Required
Simple To Use: SCOPE, VHDL Or Verilog
Can Operate On Top Level INPUT Ports Only
Can Infer All INPUT And Global PADS
Not Documented in Help, SCOPE Menu Drop Down

Synplicity SCOPE Constraint Editor Usage
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syn_insert_buffer 
Attribute Usage

Verilog Syntax
object /* synthesis syn_insert_buffer = <name> */;

Example:

VHDL Syntax
attribute syn_insert_buffer of object : signal is <name>;

Example:

module design1 (clk250, . . .);

input clk250 /*synthesis syn_insert_buffer = “CLKBUF_GTL25”*/;

output . . .;

entity design1 is

port ( clk250: in std_logic;

. . .); 

attribute syn_insert_buffer  : string;

attribute syn_insert_buffer  of clk250 : signal is "CLKBUF_GTL25";

end design1;
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syn_global_buffers
Synthesis Attribute (ProASIC3\E)

Specifies The Number Of Global Buffers To Be Used
Use This Attribute To Restrict The Number Of Global Buffer 
Resources Used by Synplicity
Attribute Is Applied Globally On The Top-level Module Or 
Entity 
Value Can Be Any Integer Between 6 And 18

Synplicity SCOPE Constraint Editor Usage



© 2006 Actel Confidential and Proprietary 256September, 2006Introduction to Libero v7.2.2

syn_global_buffers
Attribute Usage

Verilog Syntax
object /* synthesis syn_global_buffers = <maximum> */;

Example:

VHDL Syntax
attribute syn_global_buffers of object : object_type is <maximum>;

Example:

module top (clk1, clk2, clk3, clk4, clk5, clk6, 
clk7,clk8,clk9,  clk10, clk11, clk12, clk13, clk14, clk15, 
d1, d2, d3, d4, d5, q1, q2, reset) 

/* synthesis syn_global_buffers = 10 */;

entity top is 

port(      . . .       );

end top; 

architecture behave of top is

attribute syn_global_buffers : integer;

attribute syn_global_buffers of behave : architecture is 10;
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Actel Attribute and Directive Summary

NAME TYPE VALUE DESCRIPTION

alspreserve A Boolean Prevents a net from being removed during Place and Route

syn_encoding A

sequential, 
onehot, 
gray, safe Specifies encoding style for state machines

syn_keep D
1/0               
true / false

Prevents an internal signal from being removed during 
synthesis and optimization

syn_maxfan A integer Controls the maximum fanout or an instance, net or port

syn_noclockbuf A
1/0               
true / false Disables automatic insertion of clock buffers

syn_radhardlevel A string
Specifies register design technique to apply to a module, 
architecture or instance

syn_replicate A 1/0 Disables register replication

syn_sharing D
1/0               
true / false

Enables / disables the resource sharing operators insida a 
module during synthesis

syn_insert_buffer A
1/0               
true / false Directs Synplify to use specific I/O pads

syn_global_buffers A integer
Specifies the number of global buffers to be used in a 
ProASIC3\E design



© 2006 Actel Confidential and Proprietary 258September, 2006Introduction to Libero v7.2.2

Synplify and Synplify PRO for Actel
Synplify for Actel Is Equivalent to Synplicity's Synplify 
Product.

Included in Libero Gold
Limited to Actel Products Only 

Synplify Pro AE has Additional Features
Included in Libero Platinum
Limited to Actel products only
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Synplify® AE and Synplify Pro®

Features Comparison
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Synplicity Help
Synplicity Has Complete On-
line Manual 

Invoked from Help Pulldown 
or by Pressing F1
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Post-Synthesis Simulation

Simulation

Post-P&R Simulation

Design Capture

Place & Route

Programming

Post-Synthesis SimulationSynthesis
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Post-Synthesis Simulation
Steps:

Synthesize Design with Synplicity
Generate EDIF Netlist from Synplicity
Libero Automatically Creates Structural VHDL or Verilog 
Netlist

Run Post-synthesis Simulation on Structural Netlist
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Post-Synthesis Simulation
Click on “Simulation” in Design Flow window or…

Right
Mouse
Click!

Double
Click!
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Post-Synthesis Simulation
ModelSim automatically 
compiles structural netlist 
exported from Designer

Runs simulation for 1 uS
Structural library mapping 
handled by Libero
Pre-compiled libraries do 
not require compiling prior 
to simulation
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Place and Route

Post-Synthesis Simulation

Post-P&R Simulation

Design Capture

Synthesis

Programming

Place & Route

Simulation



Designer
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Open Design for Place & Route
Click on “Place & Route” in Design Flow Window or…

Right
Mouse
Click!

Double
Click!
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Designer Interface

Designer Provides Graphical 
Flow Manager to Lead 
Designer through Design Flow

Completed Tasks Highlighted 

Design Flow Steps Listed at 
Top

User Tools Grouped Below

Designer Error Manager Tabs (same as Libero)
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Designer TCL Script Support
Industry-standard Language

Tool Command Language

Launch Multiple Tools from 
Single Script

Launch Multiple Design Runs

Simulator

Synthesis

DesignerTCL
script
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Running Scripts within Designer
In File Menu, Click Execute Script File

Displays Execute Script Dialog Box

Enter name of script file

Enter arguments to be passed
to  script file

Click Run to execute script

 Tcl Scripts can be Executed from the Command Line:
Example:

d:\Libero\Designer\bin\designer script:my_script
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Recording Scripts
Designer Can Export Tcl Script File that Contains 
Commands Executed in Current Session 

Exported Tcl Script can be used to …
… re-Execute Same Commands Interactively or in Batch
… Become More Familiar with Tcl Syntax
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Importing Source Files

Multiple files can be imported 
at the same time

Libero sends Netlist and 
Constraint files to Designer  
Automatically

Import File types:
File Type Extension
EDIF *.ed*
VHDL *.vhd
Verilog *.v
Actel ADL Netlist *.adl
Criticality *.crt
Timing Constraint 
File *.sdc
ProASIC Constraint 
File *.gcf
Physical Design 
Constraint File *.pdc
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Importing Auxiliary Files

File Type Extension
Criticality *.crt
PIN *.pin
SDC *.sdc
Physical Design 
Constraint *.pdc
Value Change Dump *.vcd
Switching Activity 
Intermediate 
File/Format *.saif

Design Constraint File *.dcf

Optional step to import pin 
files, timing constraints, etc.

Import Auxiliary files after 
compile completes

Import File types:
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Entering Constraints in Designer
Option 1 - Import Files in Designer

Source or Auxiliary Files

Option 2 - Import Files in TCL Script

Option 3 - Set All Constraints Directly in Designer
Physical - PinEdit
Timing – SmartTime or Timer
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Constraint File Types
Physical

Pin Locations
SX-A, SX-S - .pin File
APA - .gcf File
Axcelerator, ProASIC3/E - .pdc File

All I/O Attributes
Axcelerator, ProASIC3/E - .pdc File

Timing
All Constraints

All FPGA families – .sdc File
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Designer File Auditing
Designer Audits Source Files to 
Ensure Imported Files Are Current

All Imported Source Files Are Date-
and Time-stamped 
Designer Notifies You if File Is 
Changed

Audit Settings Can Be Changed (File 
> Audit Settings)

Enable / Disable Auditing
Move File to New Location
Associate File with Current Date 
and Time
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Importing Files into Designer
Summary

Import the Following Source Files
EDIF, VHDL, Verilog Netlists
PDC, SDC, and GCF Files
Source Files Are Audited per User Settings

Import the Following Auxiliary Files
DCF, SDC, PDC, VCD, and SAIF Files
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Designer
Compile

Reads Netlist

Compiles Design into Actel 
Database (ADB) File

Runs Combiner

Performs Design Rule 
Checking

Checks for Netlist Errors (Bad 
Connections and Fanout 
Problems)

Removes Unused Logic 
(gobble)

Verifies that Design fits into 
Selected Device
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Compile Wizard

 Select:
Die
Package
Speed Grade
Die Voltage

 Select Restrict Pin Usage
Reserve JTAG Pins
Reserve ActionProbe Pins

 Select Ambient Temperature
Commercial (0 - 70ºC)
Industrial (-40 - 85ºC)
Military (-55 - 125ºC)
Custom

 Select Voltage Range



ProASICPLUS Netlist Optimization

TM15



Slide 280

TM15 Add slides on ProASIC3 combining
mccarthytim, 9/8/2006
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Netlist Optimization Constraints
ProASICPLUS Designs

Attempts to Remove All Cells from Netlist that Have No Effect 
on Circuit’s Functional Behavior 

Reduces Overall Size of Design
Produces Faster Place and Route Times 
Takes Advantage of Inverted Inputs of Logic Tiles 

By Default All Optimizations Are Performed on Netlist

Original Netlist Preserved
Removed Cells Back-annotated with 0ns Delay in SmartTime
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Netlist Optimization Constraints
Options

buffer - Removes All Buffers Provided Maximum Fanout Not 
Exceeded
inverter - Removes All Inverters Provided Maximum Fanout Not 
Exceeded
clocktree - Removes All Inverters and Buffers in Nets Connected 
to Clock Inputs on All Flip-Flop Cell Types
resettree - Removes All Inverters and Buffers in Nets Connected 
to Reset Inputs on All Flip-Flop Cell Types
const - Replaces All Logical Elements with One or More Constant 
Inputs (Connected to Logical “1” or “0”) by Simplified Logic 
Function

If Replacement Logic Function Is Inverter or Buffer, that Element Is 
Removed

dangling - Recursively Removes All Cells Driving Unconnected 
Nets
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Import Log
Flash Designs

Import Log Written after Compile Step in Designer
Created under <name>.dtf directory

What it Reveals
Promoted Globals
Distribution of Fanout
Device Utilization (RAMs, PLLs, IOs, Global Routes, Logic)
Internal and External Nets (Min, Average and Max fanout)
High Fanout Net Candidates to be Mapped to Spines
Internal Clocks
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. . .
Compile Output:

NOTE [removed_pwr_gnd_cells]:

Removed 2 power/ground cells from the design.

Optimizing Netlist. 

Promoting nets to globals.

Following nets are possible candidates for Globals/Spines :

Fanout Type Driver Name

48 CLK_NET CLK_pad/MUXTILE CLK_c

48 SET/RESET_NET RESET_pad/MUXTILE RESET_c

Following nets are assigned to global resources:

Fanout Name

48 CLK_c

48 RESET_c

. . .

Designer Import Log
Flash Designs

Nets assigned to global resources

Removed cells
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Designer Import Log (cont.)
. . .
Importer Summary
===============
Part-Package: APA075-PQ208 

Core Slots:         3072
RAM/FIFO Slots:       12
I/O Slots:           158    (Globals: 4)   (PLLs: 2)

Core Cells:        493  -->  Usage: 16.0 percent
RAM/FIFO Cells:      9  -->  Usage: 75.0 percent
IOs:                14  -->  Usage: 9.0 percent
PLLs:                1  -->  Usage: 50.0 percent

.   .   .

Nets           | Count  | Average Fanout | Max. Fanout

---------------|--------|----------------|------------

Global         |     2  |        48.0    |          48

External       |    18  |         2.9    |          20

Internal       |   113  |         1.9    |          16

---------------|--------|----------------|------------

Total          |   133  |         2.7    |          48

. . .

Actual number of tiles used

Net statistics
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Identifying Removed Cells
Flash Designs

While Compile or Layout Is Running, Temporary File Named 
deleted_blocks Is Created under <name>.dtf Directory

Lists All Deleted Cells
This File Automatically Removed after Layout Is Finished

Save File before Layout Completes or Run Place Option without Route 
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Netlist Optimization Example
Flash Designs

-- example to test APA optimization
library ieee;
use ieee.std_logic_1164.all;
entity test is
port (A, B, presetn, resetn, clk: in std_logic;

out1, out2, Q1, Q2: out std_logic);
end test;

architecture RTL of test is
begin
process (clk, resetn)
begin
if (resetn = '0') then  Q1 <= '0';
elsif (clk 'event and clk = '0') then  Q1 <= A;
end if;
end process;

process (clk, resetn, presetn)
begin
if (resetn = '0') then    Q2 <= '0';
elsif (presetn = '0') then    Q2 <= '1';
elsif (clk 'event and clk = '0') then  Q2 <= B;
end if;
end process;

out1 <= A and not B;
out2 <= not A xor not B;
end RTL;

Deleted blocks
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Successful Compile

Compile Button Turns 
Green if Compile Completes 
Successfully

Errors Indicated in 
Designer Log Window



MultiView Navigator
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MultiView Navigator
MultiView Navigator 
Includes the Following 
Tools:

PinEditor, I/O Attribute 
Editor, NetlistViewer, 
and ChipPlanner

Supported for the 
following families:

Fusion, ProASIC3\E, 
APA, A500K, AX, SX-A, 
SX-S, eX

Allows Cross-probing 
Among Different 
Designer Tools

Click one of these buttons to open MVN
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MultiView Navigator

Design
Window

World View
Window

Log
Window

Working
Area

Toolbar IconsZoom Controls
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MultiView Navigator
Windows

Design Window
View Design as Logical Blocks, Physical Elements, Ports, Nets, 
and Regions

World View Window
Shows Position of Current Viewing Window Relative to Chip

Working Area Shows Current Active Tools
Tile or Cascade Active Tools

Log Window Keeps Running Log of Activity
Output – Shows All Messages
Errors – Shows Error Messages
Warnings – Shows Warning Messages
Info – Shows Informational Messages
Find Window – Keeps Result of Find Function for Later Usage
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MultiView Navigator Toolbar
File ->

Commit – Writes any Changes Made in Editors to Design
Prelayout Check – Verifies Placement Changes in Editors Are 
Legal

Edit ->
Undo/Redo – Allows User to Undo a Mistake or Redo an 
Accidental Undo
Find – Enables Find Interface

Zoom Controls
Zoom Region, Zoom In, Zoom Out, Zoom to Fit

Assignment Options
Place, Unplace, Lock (Fix), Unlock (Unfix)

Tools Menu
ChipPlanner, PinEditor, NetlistViewer, I/O Attribute Editor

“1 click" commands
Commit and Check
Lock All
Unlock All
Un-assign All from Location
Un-assign All from Region
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MultiView Navigator
Prelayout Checker

Infeasible Constraints Identified pre-Layout
Automatically Runs when You Commit from MVN
Users Can Run Using MVN Command Tools->DRC 

Enhanced Checks
Overlapping Region Checks
Resource Overbooking
I/O Technology Checks
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MultiView Navigator
Find / Search

Search for Instances, Nets or Ports
Wildcard (*) Matching
Advanced Options - Choice of Log Window Pane for Search 
Results

Cross-probing from Find Tab to the other Four Windows



PinEditor
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Pin Assignment Options
I/O Locations Can Be Assigned as Follows:

Automatically by Designer Software during Layout
By Importing One of the Following:

. Gatefield Constraint File (.gcf) (ProASIC and ProASICPLUS)

. PIN File (Antifuse Devices)
Physical Design Constraint (.pdc) (Axcelerator and ProASIC3/E) 

Manually using PinEdit Tool in Designer
Pin Assignments May Be Exported for Later Use
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MultiView Navigator
PinEditor
Graphical Pin Location Editor

Drag and Drop Placement of Pins
Fix Pin Locations for Subsequent Place and Route Runs

Flip Display
Enables Assignments as if Looking from Top or Bottom of Chip

Assign I/O Bank Properties for Axcelerator and ProASIC3E

Pinout Can Be Printed for Documentation

Right
Mouse
Click!
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I/O Bank Configuration
Axcelerator, ProASIC3E

I/O Bank 
Configuration

Select Bank
Select I/O Standards

Incompatible 
Options
Disappear when 
Selecting I/O 
Standards

Select Low-power 
Mode
Select Input Delay

Select bank

I/O standards

I/O bank 
VCCI/VREF  
not editable
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VREF Pin Assignment
Axcelerator and ProASIC3E

Select Package Pin And Click Right Mouse Button
Select “Use Pin for VREF”

Right
Mouse
Click!
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Designer
Automatic I/O Bank Assignment

I/O Bank Assigner for A3P/E and AX
Runs automatically during layout
Is available when at least one I/O bank is unassigned
Automatically assigns voltages to I/O banks that do not 
have I/Os assigned

Fills them with compatible I/Os
Assigns VREF pins if required
Respects manual assignment already in place 
Maintains placement quality and performance

No impact on device performance
Can be controlled manually from within the MultiView 
Navigator
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Pin Assignment Recommendations
Enter Design as Completely as Possible

Don’t Worry about Functionality

Compile (Ignore Warnings) and Layout

“Fix”All Pin Assignments 
Edit > Select All then Edit > Fix

Send Pin Report to PCB Layout

Continue Working Out Bugs
Future Layouts Will Honor “Fixed” Assignments
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Exporting Pin Report
Pin Report Can be Exported from Designer
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Exporting Pin Constraint File
Pin Constraint File Can be Exported from Designer

File Type
File 
Extension Family

PIN file *.pin

ACT1, ACT2, 
ACT3, MX, XL, 
DX, SX, SX-A, 
eX

Gatefield Constraint file *.gcf
ProASIC,              
ProASIC PLUS

Physical Design Constraint *.pdc

Axcelerator, 
ProASIC3\E, 
Fusion



I/O Attribute Editor
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MultiView Navigator 
I/O Attribute Editor

Input/Output Attribute Editor
Select (Varies by Family):

I/O Standard
I/O Threshold
Slew Rate
I/O Power-up State

Enter Load Capacitance of 
Load

Does Not Change SDF File 
Generation

Spreadsheet-like Sort, Copy, 
Paste
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MultiView Navigator 
I/O Attribute Editor (cont.)

With multiple rows selected, changing the 
value of a drop-down item with CTRL key 
pressed will change the value for all rows

Hold down CTRL key to 
select multiple rows

Double click on column to sort display by 
that column 
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MultiView Navigator
Package Pins View

Package Pins View Shows All Pins on Package 



Netlist Viewer
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MultiView Navigator
Netlist Viewer

Displays Netlist in Hierarchical Manner
Explore each Level of Hierarchy and Trace Signals

Search Window –
shows results of 

searches

Schematic View 
Window –
displays a 
graphical 
representation of 
the netlist
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MultiView Navigator
Netlist Viewer (cont.)

Viewing Options
Push, Pop, Jump to Top 
Go to First Page, Go to Last Page, Go to Next Page, Go to 
Last Page 
Right-click on Net to Follow Net to Other Pages or Net 
Driver

Highlight, Highlight Append, un-Highlight, un-Highlight All
Allows Page Splitting

Allows User to Decide if All Elements on that Level Are 
Shown as Single Page
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MultiView Navigator
Netlist Viewer (cont.)

View Pre- and Optimized Netlists for ProASIC3\E, ProASICPLUS and 
Axcelerator

Pre-optimized Netlist Is Original Hierarchical Netlist
Optimized Netlist is Flattened

Reflects what other Tools Use (ChipEdit, PinEdit)
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MultiView Navigator
LogicalCone

Helps View Critical Portions of Netlist
Identify Critical Paths using SmartTime 
Add this Logic to LogicalCone
Incrementally Add / Remove Logic from Cone
CrossProbe from / to LogicalCone
All NetlistView Features available in LogicalCone
New LogicalCone Tab in Hierarchy Window
New LogicalCone Menu Accessible from NetlistViewer
Can Simultaneously Create Multiple Cones
Set of Macros Can Be Highlighted, then Added to Cone
LogicalCone Data No Longer Valid after Recompile
Applies to All Families Supported by MVN
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LogicalCone
User Interface



ChipPlanner
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ChipPlanner
Editing and Floorplanning Support for:

Fusion, ProASIC3\E, ProASICPLUS, ProASIC, Axcelerator, eX, 
SX-A and SX-S Families
Use ChipEditor for All other Actel FPGA Families

ChipPlanner Capabilities:
Editing

Place, Unplace, or Move Logic and I/O
View Macro Placements Made during Layout
View Net Connections with Ratsnest or Route View
View Architectural Boundaries
View and Edit Silicon Features, such as I/O Banks
View Placement and Routing of Paths when Used with SmartTime

Floorplanning
Create and Assign Logic or Nets to Regions

Cross-probe with Silicon Explorer to Select Probes
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ChipPlanner Terminology
Region

Defined sub-Portion of Die
Shapes - Rectangular or Rectilinear (Union of Rectangles)
Types:

Empty - No Logic Can Be Put into this Region 
Inclusive - Assigned Logic Must Be Put into this Region

Other Unassigned Logic Can Be Added to this Region by Layout
Exclusive - Only Assigned Logic Can Be Put into this Region

Not Supported for APA or A500K

Assign
Place Logic into Particular Region or Location

Similar to “Place” in ChipEditor

Lock
Finalizes Allocation of Logic in Particular Location

Similar to “Fix” in ChipEditor
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ChipPlanner
Editing and Floorplanning

Drag Logic or I/O to Desired Location

ChipPlanner Floorplanning Functions
Create Logic Region
Create Empty Region
Select Region
Move Region
Delete Region
Resize Region
Assign/Unassign Logic to Region

Regions Can Span Logic, Memory Cells and I/O

Create empty region

Create inclusive region

Create exclusive region

Delete region

Assign / 
Unassign

Create local clock region
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ChipPlanner
Empty Region

Region > Create Empty
No Logic Assigned to Empty Regions
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ChipPlanner
Inclusive Region

Region > Create Inclusive
Assigned Logic Put in Inclusive Region

Other Logic May also Be Put in this Region
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ChipPlanner
Exclusive Region (Axcelerator and ProASIC3/E)

Region > Create Exclusive
Only assigned logic placed in exclusive region
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ChipPlanner
Local Clock Region (ProASICPLUS)

Region > Create Local Clock
Assign net to a spine region graphically
All logic connected with the net will be assigned to the 
spine region
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ChipPlanner
Quadrant Clock Region (ProASIC3/E)

Region > Create QuadrantClock
Graphically Assign net to a Quadrant Clock
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ChipPlanner
Region Color Control

Individual Region Color Control
Regions Have Different Default Colors Based on Types
Can Change Each Region’s Default Color
Region Colors Saved in .adb File
Region Colors Reset to Defaults upon Recompile
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ChipPlanner
Region Properties

Region > Properties

Indicates:
Region Type
Region Width, Height and Origin
Region Usage

Shows Region Default Color
Default Color Can be Changed

Also Provides Access to 
Assignment Window

Region size and 
utilization

Change region color
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MultiView Navigator
Region Color Control Example
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ChipPlanner
Logic Assignment

Two Logic Assignment Methods
Assignment Window (Region > Assign/Unassign Logic…)

Provides Search and Selection Capability
Also Available from Region Properties Dialog Box

Drag and Drop Logic into Region

Checkmark Indicates Assigned Logic
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ChipPlanner
Display Settings

Users Can Show/Hide Object and 
Assign Color to Resource

View > Display Settings
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ChipPlanner
Viewing Nets

Select Net View Options from Nets Toolbar:
Display No Nets

Display Input Nets
Display Output Nets

Display Input and Output Nets
Display Ratsnest

Display Routes
Routes Option for ProASIC, ProASICPLUS, ProASIC3/E, Fusion

Hide nets

Show inputs only
Show outputs only

Show Ratsnest

Show routesShow nets

View Ratsnest View Routes
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ChipPlanner
Highlighting Nets

Selected Nets Can Be Highlighted to Aid 
Analysis

Select Net from Design Window Nets Tab or 
Search Results
Change Highlight Color from Toolbar or Edit 
Menu

Highlight

Unhighlight All

Highlight Color
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ChipPlanner
ProASIC/ProASICPLUS

Floorplanning Capabilities 
Define Rectangular Regions

x/y Location Displayed During Region Resize
Only Empty and Inclusive Regions Supported for APA and A500K

Assign Logic, Regular I/O and Regular Nets to Region
Drag and Drop Assignments
Selection Highlighting and Color Selection

Create Local Clock Region
Multi-region Assignments Not Recommended 
I/O Assignments 
View Spines Created through GCF
View Routing 
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Silicon Support
ProASIC/ProASICPLUS

Multi-type Region Support
Region Support for RAM
LocalClock Regions Can Include RAM and I/O

Controlled by Compile Option (Designer -> Options -> 
Compile)
Need to Recompile after Modifying Option
Default is ON for New Designs from Designer 6.0 on

Top1 Top2 Top3 …

1) Core + 
memory

core

i/o i/o i/o

i/o

i/o

i/o

2) Core + 
memory + I/O

spine

RAM block
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ChipPlanner
Axcelerator

Floorplanning Capabilities 
Define Rectangular Regions

Empty, Exclusive and Inclusive Region Support for Axcelerator
Modify Region types (Inclusive / Exclusive)

Assign Logic and Nets to Region
I/O Assignments
PLL and RAM 
Assignments

Drag and Drop 
Assignments
Multi-region 
Assignments
NOT 
Recommended
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Silicon Support
Axcelerator

LocalClock Region Support
Created through PDC only
PDC Syntax

assign_local_clock –type routing_resource_type –net netname  
<local_clock_region> [local_clock_region] [local_clock_region] …
routing_resource_type is either hclk or rclk
local_clock_region is Hierarchical Resource Name of Specific Clock 
Region

Tile3C.Row0

Tile 3A

Tile1C.RowN-1

A          B           C

3      2       1

Tile3b.colN-1
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ChipPlanner
Scripting Support

ProASIC/ProASICPLUS

Existing GCF Format and Capabilities
GCF Enhancement to Support Partial I/O Regions

Axcelerator
PDC Commands for Floorplanning

Define and un-Define Region
Rectangular
Rectilinear (Currently Only Supported in PDC)

Region Types
Empty
Inclusive
Exclusive

Assign and Unassign Resources
Macros
Nets

Reset Floorplan
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MultiView Navigator
Active Lists

“Enables User To Compile Lists Of Important Resources
Instances
Nets
Macros
Regions

Default Lists
Unassigned Instances
Unassigned Pins
Clock Nets

Navigate Thru Design To Find Status Of  Important 
Design Resources
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MultiView Navigator
Viewing Active Lists

Open Default Active Lists from MVN Tools Menu
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MultiView Navigator
Creating Active Lists

Users Can Create New Active Lists

Select instances

Name List



© 2006 Actel Confidential and Proprietary 339September, 2006Introduction to Libero v7.2.2

MVN v7.2 Enhancements
Global Planner Function Within the MVN Tools Can Be Used To 
Place Global Nets Automatically

Global Planner Can Distinguish Between Locked And Non-locked 
Quadrant Clock Regions

Each Quadrant Clock region can be marked as locked
New capabilities: 

Each Quadrant Clock region can be locked manually using a PDC file 
or through the MVN 
Each locked Quadrant Clock region is not changed; Non-locked 
Quadrant Clock regions are deleted and recreated each time the 
Global Planner is executed 



ChipEditor
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ChipEditor
ACT1,2,3, MX, SX

ChipEditor icon
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ChipEditor
ACT1,2,3, MX, SX

Graphical Placement Editor
Place Logic Modules and 
I/O 

ChipEdit Shows Routing 
Congestion with “Rats Nest”
Views

Gives More Control to 
Power User
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ChipEditor
Viewing Routing

Rats Nest View Shows Connectivity
Example – CLKBUF Connected to Several Registers
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ChipEditor
Viewing Routing (cont.)

Minimum Spanning Tree Mode
Shows Connectivity between Selected Macros



Timing Constraints and Analysis
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SmartTime Overview
SmartTime is Actel’s New Static Timing Analysis Tool

SmartTime Replaces the Original Timer for:
SX-A, RTSX-S, eX, AX, RTAX-S
500K, APA, ProASIC3\E and Fusion
All Future Products
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SmartTime Features
Graphical Constraint Entry

SDC Constraint Support

SDC Constraint Checker

Analysis
Cross-clock Domain Analysis
Flexibility in Clock Domain Selection

Improved Ease-of-Use
Separate Constraint & Analysis Views

Separate Maximum & Minimum Analysis Views
Clock Domain Browser for the Analysis View

Visual Constraint Dialogs
Customizable Timing Information for the Paths List
Constraint Entry from the Analysis Window
Customizable Timing Reports
Filtering Capabilities
Persistence of User Settings
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SmartTime
SDC Constraint Support

Constraints
SDC create_clock
SDC create_generated_clock
SDC set_input_delay
SDC set_output_delay

Exceptions
SDC set_false_path –from –through –to
SDC set_multicycle_path –from –through –to
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SDC Constraint Support by Family

1 Supported for analysis only
2 Only -through option supported for layout

SDC Constraint Fu
si
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3E

Pr
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SI
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ce
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ra

to
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SI
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a
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a

2
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SmartTime Windows
SmartTime Includes of Separate Constraint Editor and 
Timing Analysis Windows

Constraint Editor – GUI Based Constraint Entry
Timing Analyzer Provides Delay Information

Click to launch 
SmartTime 
Constraint Editor 
or Analysis Views
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SmartTime
Constraints Editor

Use Constraints Editor to:
Enter or Edit Timing Requirements:

Clock Frequency, Input and Output Delays
Enter or Edit Timing Exceptions:

Max Delay, Multicycle Paths, False Paths
Browse Clock Domains
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SmartTime
Timing Analysis View

Determine Maximum Operating Frequency
Verify Setup and Hold Requirements
Identify Timing Violations
Browse Clock Domains
Set Constraints on Specific Pins or Sets of Paths
Copy, Print, Expand or Cross-Probe Sets of Paths
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SmartTime Toolbar
The SmartTime Toolbar Contains Commands for 
Performing Common Operations.

Tool Tips Are Available for Each Button.

Commit

Print

Copy

Paste

Edit current 
constraint

Delete 
selected 

constraints

Undo

Redo

Max delay 
analysis View

Timing 
constraint 

View

Recalculate 
All

Min 
delay 

analysis 
View

Add clock 
constraint

Add     input   
delay constraint

Add   
output 
delay 

constraint

Add false      
path constraint

Add max delay 
constraint

Clock domain 
manager

Path set 
manager

Check timing 
constraints

New multicycle 
clock constraint
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SmartTime Constraint Entry
Clock Constraints

Input and Output Delay Constraints

Clock Exceptions
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SmartTime
Clock Domains

SmartTime Detects Possible Clocks by Tracing Back from 
the Clock Pins of all Sequential Components Until it Finds:

An Input Port
The Output of Another Sequential Element, or 
The Output of a PLL

SmartTime Classifies Clock Sources Into Three Types:
Explicit Clocks
Potential Clocks
Clock Network

Each Clock Domain Contains at Least 3 Path Sets:
Register to Register
External Setup or Hold
Clock to Out



© 2006 Actel Confidential and Proprietary 356September, 2006Introduction to Libero v7.2.2

SmartTime
Entering Clock Constraints

Visual Constraint Dialog Box Simplifies Constraint Entry

Select Clock Source 
from pull-down Menu

Enter Period or Frequency

Enter Offset and 
Duty Cycle

Select Starting Edge
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SmartTime Clock Constraints
Clock Constraints in Constraint Editor

Select Constraint to Add, Edit or Delete

Double-click to edit constraint

Double-click constraint type to add constraint
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SmartTime
Generated Clock Constraints

Constraints For Internally Generated Clock Can Be 
Specified Using Generated Clock Constraints

Useful For Constraining PLL Outputs
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SmartTime
Entering Generated Clock Constraints

Select pin for 
generated clock

Specify edge relationship 
to reference clock

Enter multiplication 
and division factors to 
generate frequency

Specify clock 
reference
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SmartTime
Generated Clocks - PLL Outputs

Constraint for PLL Outputs
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SmartTime Constraint Entry
Clock Constraints

Input and Output Delay Constraints

Clock Exceptions
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CK

SmartTime
Input Constraints

Input Constraints can be Entered as Input Delay or External Setup/Hold
Input Delay – Enter Input Delay in Terms of Delay Budget Outside FPGA

SDC Format
External Setup / Hold – Specify Input Delay Budget Inside FPGA

Used by Previous Actel Timer

MyDesign

Clock
Generator

Input Delay
External Setup / HoldCK
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Input Constraints
Input Delay

Visual Constraint Dialog Box Simplifies Constraint Entry

Enter Min and Max 
delay or same value 
for both
Minimum Delay for 
analysis only

Select Input Port

Select Clock Port 
and Reference Edge

Select Input Delay
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Input Constraints
External Setup / Hold

Select Input Port

Select Clock Port

Enter Hold 
Requirement

Select External Setup/Hold

Enter Setup 
Requirement
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SmartTime
Input Constraints

Input Delay Constraints in Constraint Editor
Constraint Displayed as External Setup / Hold and Input Delay

Double-click to edit constraint

Double-click constraint type to add constraint
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SmartTime
Output Constraints

Output Constraints Define the Delay of an Output Relative to a Clock 

Output Constraints can be Entered as Clock-to-Output or Output Delay
Clock-to-Output: Specifies the Output Delay by Specifying the Timing 
Budget Inside the FPGA (default)
Output Delay: Specifies Output Delay Constraint by Specifying the 
Timing Budget Outside the FPGA

SDC Format

MyDesign

CK

OUT1

Clock-to-Output Output Delay



© 2006 Actel Confidential and Proprietary 367September, 2006Introduction to Libero v7.2.2

Output Constraints
Clock-to-Output

Visual Constraint Dialog Box Simplifies Constraint Entry
Select Output Port

Select Clock Port

Enter Min and Max 
delay
Minimum Delay for 
analysis only

Select Clock-to-Output
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Output Constraints
Output Delay

Select Clock Port

Minimum Delay

Maximum 
Delay

Select Output Delay Select Output Port
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SmartTime
Output Delay Constraints

Output Constraints in Constraint Editor
Displayed as Clock-to-Output and Output Delay
Select Constraint to Add, Edit or Delete

Double-click to edit constraint

Double-click constraint type to add constraint
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SmartTime Constraint Entry
Clock Constraints

Input and Output Delay Constraints

Clock Exceptions
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Timing Exceptions
False Paths

The False Path Constraint Removes Timing Requirements 
on Specified Paths

Starting Points Are Input Ports or Register Clock Pins 
Ending Points Are the Register Data Pins or Output Ports

False Paths Are Not Considered During the Timing 
Analysis

False Path Constraints Take Precedence Over Multiple 
Cycle Path Constraints and Overrides Maximum Delay 
Constraints
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SmartTime
Entering False Path Constraints

Specify From, To, Through Pins
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False Path Constraint
Source Pins

Specify Starting Point for False Path

Filter pin names

Add or remove pins 
from source list



© 2006 Actel Confidential and Proprietary 374September, 2006Introduction to Libero v7.2.2

False Path Constraint
Through Pins

Select a List of Pins or Nets for the False Path Passes 
Through
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False Path Constraint
Destination Pins

Specify the End Points for the False Path
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False Path Example
Multiplexer S Input Never Changes

FF1, FF2 and FF3 to FF4 through MX0:A are False Paths

S input always 1
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False Path Example (cont.)
False Path Constraint Through MX0:A

False Path
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False Paths in Constraint Editor
False Path Constraint in Constraint Editor

Select Constraint to Add, Edit or Delete
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Timing Exceptions
Multicycle Paths

The Multicycle Path Constraint Overrides the Single Cycle 
Timing Requirement Between Sequential Elements

The Number of Clock Cycles for Setup or Hold Check Is 
Specified in the Constraint

False Path Constraints Take Precedence Over Multicycle 
Path Constraints

CKsource

CKsink

Multicycle path setup relationshipDefault setup relationship
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SmartTime
Entering Multicycle Path Constraints

Specify Path Multiplier and From, To, Through Pins

Add Path Multiplier

Browse for From, Through 
or To pins

Enter path multiplier
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Multicycle Path Example
Binary counter

Binary Counters Contain Multicycle Paths
Enter Multicycle Constraint to Obtain Proper Timing Analysis

Multicycle 
path
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Timing Exceptions
Maximum Delay

The Max Delay Constraint Is Used To Specify The 
Maximum Delay For Timing Paths In The Design

Max Delay Is A Timing Exception And Overrides The 
Timing Requirement Between Sequential Elements

Max Delay Can Also Be Used To Constrain Input To Output 
Paths In Combinatorial Designs
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Timing Exceptions
Maximum Delay

Maximum Delay Constraint Overrides Clock Constraint

Browse for From, Through 
or To pins

Enter Max Delay
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SmartTime 7.2
New Features
Clock Source Latency
Asynchronous Checks
Datasheet Generation
Tcl Commands
Additional Ease-of-Use Features

User sets management (editing, adding exceptions…)
Clock network details in expand path
Automatic creation of generated-clocks on PLLs
Multicycle with hold specifier
Expanding parallel paths
Reports in spreadsheet format
Logic stage count column in analysis window
Clock constraints in summary window
Select all in add path set dialog
Path aware exceptions
Improved auto-TDPR constraint setting
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SmartTime 7.2
New Constraint Entry Features

Specify Multicycle Path Constraint for Setup, Hold or 
Both

Supported in GUI and SDC Commands

Specify Clock Source Latency
Use to Model Clock Insertion Delay when Clock Generation 
is not part of the Design

Specify Early and Late Clock Arrival Times
Analyze Performance for Clock Jitter

Automatic Creation of Generated Clocks

New TCL Commands
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SmartTime 7.2
Multicyle Path Constraints

Specify Whether Multicycle Path 
Applies to Setup Check, Hold Check or 
Both

Specify different multiplier for 
setup analysis and hold analysis
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Specify delay when clock is generated outside the design

Specify clock jitter

Clock Source Latency can be attached to any clock 
constraint (internal or external)

Clock Source Latency:
Definition
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Clock Source Latency:
Constraints Specification
Specify Clock Insertion Delay
Specify Early and Late Times for Rising and Falling Edges
SDC Constraint: set_clock_latency
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SmartTime 7.2 
Automatic Creation of Generated Clocks

Automatic Creation Of Generated Clock Constraint Based On 
Static Configuration of PLLs for AX, RTAX-S, Fusion, ProASIC3/E

No Effect Unless The Clock Reference Has A Clock Constraint

auto-generated
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SmartTime 7.2
New TCL Commands

st_create_set - Creates A Set Of Paths To Be Analyzed
st_edit_set - Modify The Paths In A User Set
st_remove_set - Deletes A User Set From The Design
st_commit - Saves The Changes Made In SmartTime To The 
Design .adb File
st_restore - Restores Constraints Previously Committed In 
SmartTime
st_expand_path - Displays Expanded Path Information For 
Paths
st_set_options - Sets options for timing analysis
st_list_paths - Displays the list of paths in the same tabular 
format shown in SmartTime



Timing Analysis with SmartTime
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Timing Analysis with SmartTime
Design Summary

Setup and Hold Checks

Cross Clock Domain Analysis

Adding User Sets and Filtering

Customizing the Analysis View

Cross-Probing with MVN Tools
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SmartTime Analysis View
Design Summary

Performance Summary is Displayed in Maximum and 
Minimum Delay Analysis View

√ - Indicates Timing Requirements Met for That Domain
X – Indicates There Are Violations Within the Domain
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SmartTime
Design Summary

Minimum pulse width check performed on paths in design
Information is used to determine the maximum operating 
frequency reported in the SmartTime Design Summary
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Timing Analysis with SmartTime
Design Summary

Setup and Hold Checks

Cross Clock Domain Analysis

Adding User Sets and Filtering

Customizing the Analysis View

Cross-Probing with MVN Tools
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SmartTime
Setup Check

Setup Check is Displayed in Maximum Delay Analysis View

Setup Check Calculation
Arrival time = Launch edge (0) +  max Clock to FF1 + max Data path
Required time = Capture edge (T) + min Clock to FF2 – Setup of FF2
Slack = Required – Arrival = Violation if < 0

Setup check
launch edge

Setup check
capture edge
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Setup Check in SmartTime

Setup Check
Arrival time = Launch edge (0) +  max Clock to FF1 + max Data path
Required time = Capture edge (T) + min Clock to FF2 – Setup of FF2
Slack = Required – Arrival = Violation if < 0
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Setup Check w/ Multicycle Path
SmartTime Uses Multicycle Path Constraint in Setup Check

Setup Check Calculation
Arrival time = Launch edge (0) +  max Clock to FF1 + max Data path
Required time = Capture edge (2T) + min Clock to FF2 – Setup of FF2
Slack = Required – Arrival = Violation if < 0

Setup check
launch edge

Setup check
capture edge
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Setup Check w/ Multicycle Path
Add Multicycle Exception from Analysis View

Right-click on the Path in the Analysis Window
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Setup Check w/ Multicycle Path
Add Multicycle Exception

Fields are pre-filled with
the path information

Path multiplier = 2
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Setup Check w/ Multicycle Path

Setup Check
Arrival time = Launch edge (0) +  max Clock to FF1 + max Data path
Required time = Capture edge (2T) + min Clock to FF2 – Setup of FF2
Slack = Required – Arrival = Violation if < 0
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SmartTime
Expanded Path Timing Information

Right-click a Path in the Path List Displays the Expanded 
Path in a Separate Window
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SmartTime
Expanded Path (cont.)

Expanded Path View Includes a Schematic of the Path

Right click 
in window 
to zoom
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SmartTime
Hold Check

Hold Check is Displayed in the Minimum Delay Analysis View

Hold Check Calculation
Arrival time = Launch edge (0) +  min Clock to FF1 + min Data path
Required time = Launch edge (0) + max Clock to FF2 + Hold of FF2
Slack = Arrival – Required = Violation if < 0

Hold check
launch edge
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SmartTime
Hold Check (cont.)

Hold Check
Arrival time = Launch edge (0) +  min Clock to FF1 + min Data path
Required time = Capture edge (0) + max Clock to FF2 + Hold of FF2
Slack = Arrival – Required = Violation if < 0
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SmartTime
External Setup Check

External Setup Defines the Timing Requirements at the Input Pins

External Setup Check is Displayed in the Maximum Delay Analysis View 
for Each Clock Domain

External Setup Check Calculation
Arrival time = max Input Pad to FF1
Required time = min Clock to FF1 - Setup of FF1
External Hold = Arrival - Required

CLK

DATA

Flip-Flop

Gate-A
Inst A1

D

CLK Global Clock 
Network
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SmartTime
External Setup Check

External Setup Check
Arrival time = max Input Pad to FF1
Required time = min Clock to FF1 - Setup of FF1
External Setup = Arrival - Required
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External Setup Check w/ Input Delay 
Constraint
Enter Constraint as Input Delay
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External Setup Check w/ Input Delay 
Constraint

External Setup Check Calculation
Arrival time = Launch edge (0) + max input delay + max Data path
Required time = Capture edge (T) + min Clock to FF1 – Setup of FF1
Slack = Required – Arrival = Violation if < 0
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External Setup Check w/ External Setup 
Constraint
Enter Constraint as External Setup/Hold
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External Setup Check w/ External Setup 
Constraint

External Setup Check Calculation
Arrival time = Launch edge (0) + max input delay + max Data path
Required time = Capture edge (T) + min Clock to FF1 – Setup of FF1
Slack = Required – Arrival = Violation if < 0
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SmartTime
External Hold Check

External Hold Defines the Timing Requirements at the Input Pins

External Hold Check is Displayed in the Minimum Delay Analysis View 
for Each Clock Domain

External Hold Check Calculation
Arrival time = min Input Pad to FF1
Required time = max Clock to FF1 - Hold of FF1
External Hold = Arrival - Required

CLK

DATA

Flip-Flop

Gate-A
Inst A1

D

CLK Global Clock 
Network
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SmartTime
External Hold Check

External Hold Check – Minimum Delay Analysis View
Arrival time = min Input Pad to FF1
Required time = max Clock to FF1 + Hold of FF1
Slack = Arrival – Required = Violation if < 0
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SmartTime
Clock to Output Check

Clock to Output is Displayed in the Maximum Delay Analysis View for 
Each Clock Domain

Clock to Output Calculation
Arrival time = Launch edge (0) + max Data path
Required time = Capture edge (T)
Slack = Required – Arrival = Violation if < 0

CLK

DATA

Flip-Flop

Output

Clock Global Clock 
Network

Gate-A
Inst A1
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Clock to Output Check w/ Output Delay 
Constraint
Enter Constraint as Output Delay
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Clock to Output Check w/ Output Delay 
Constraint

Setup Check
Arrival time = Launch edge (0) + max Data path
Required time = Capture edge (T) – Output Delay
Slack = Required – Arrival = Violation if < 0
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Clock to Output Check w/ Clock to Output 
Constraint
Enter Constraint as Clock-to-Out
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Clock to Output Check w/ Output Delay 
Constraint

Setup Check
Arrival time = Launch edge (0) + max Data path
Required time = Capture edge (T) – Output Delay
Slack = Required – Arrival = Violation if < 0
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SmartTime
Enhanced Min Delay

Provides more accurate min delay evaluation
Precise hold-time analysis
Silicon characterization-based approach

Based on the spread of the characterization curve
Endorsed on all paths in a clock domain when the clock is 
using a global network
Viewed in the SmartTime “Minimum Delay View”
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dBm dBM

dTm dTM

dWm dWM

dBm dWM

SETUP Check requires the longest data path:
dWM, dTM, or dBM of Gate-A depending on the case under analysis

HOLD Check requires the shortest data path:
dWm, dTm, or dBm of Gate-A depending on the case under analysis

Gate-A delay variation

Case analysis: 
B, T, W

Worst
CLK

DATA

Flip-Flop

Data

Clock

Includes Process, Voltage, & Temperature

Typ

Best

Mixed 
Cases

The Min-Delay Problem:
Gate delays Case Study

Gate-A
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The Min-Delay Problem: 
An Example

Example

Theoretically
Setup check uses longest data path delay = Max ( ∑ (Max(Gatei)) ) = 23
Hold check uses shortest data path delay = Min ( ∑ (Min(Gatei)) ) = 11

So far, we had no Min(Gate) delay, so we use Max(Gate) delay
Shortest data path delay = Min ( ∑ (Max(Gatei)) ) = 18

Therefore, we were overestimating the minimum data path delay

FFFF

Max delay
Min delay

Longest data path delay

Shortest data path delay

1…2
2…3 1…2 1…2 1…2

1…2

2…3 2…3

2…3 2…3

2…3

2…3

1
2

1
2
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Enhanced Min-Delay (EMD)
Application

Register-to-Register hold

External hold

Clock to out

Arrival time

Required time

Arrival time

Required time

Arrival time
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Enhanced Min-Delay (EMD)
Support & Limitations

Supported Products
Release 6.3: APA, AX, RTAX-S
Future: A3P/E and all future products

New versus Existing Designs
EMD only activated for designs started in 6.3 and beyond

Resources
EMD is endorsed on all paths in a clock domain when the 
clock is using a global network

Other Limitations
No SDF(min) export
No TDPR support in addressing min-delay violations
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Timing Analysis with SmartTime
Design Summary

Setup and Hold Checks

Cross Clock Domain Analysis

Adding User Sets and Filtering

Customizing the Analysis View

Cross-Probing with MVN Tools
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SmartTime
Cross-Clock Domains

SmartTime Performs Setup Check Across Clock Domains
SmartTime Looks at the Relationship Between the Active Clock Edges Over a 
Full Repeating Cycle, Equal to the Least Common Multiple of the Two Clock 
Periods
For Each Capture Edge at the Destination Flip-flop, SmartTime Assumes That 

the Corresponding Launch Edge Is the Nearest Source Clock Edge Occurring 
Before the Capture Edge

CLK2

FF2FF1

CLK1

CLK1FF1

CLK1FF2

Repeating cycle

setup1 setup2
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SmartTime
Activating Cross-Clock Domain Analysis

Activate Cross-clock Domain Analysis for a Particular 
Clock Domain

SmartTime Automatically Detects All Other Clock Domains 
With Paths Ending at Selected Clock Domain
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SmartTime
Cross-Clock Domains in SmartTime

Inter clock domain
clk2 to clk1

Inter clock domain
clk1 to clk2
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Timing Analysis with SmartTime
Design Summary

Setup and Hold Checks

Cross Clock Domain Analysis

Adding User Sets and Filtering

Customizing the Analysis View

Cross-Probing with MVN Tools
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SmartTime
Adding Path Sets

Users Can Create and Manage Custom Path Sets for Timing 
Analysis

Custom Path Sets Appear Under User Sets in Domain Browser

Right click in domain 
browser area
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SmartTime
Adding Path Sets (cont.)

Enter Path Set Name and Select Source and Sink Pins

Enter path set name

Filtering for 
source and sink 
pins
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SmartTime
Adding Path Sets (cont.)

Maximum Delay Analysis View With Added Path Set

Custom Path Set
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SmartTime
Filtering Management

Filters Can Be Used to Limit Path Set Content
Filters Are Displayed Below Set Under Which It Was Created
Filters Can Be Nested

Enter source and sink 
pins for filter
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SmartTime
Filtering Management (cont.)

Stored Filter
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Timing Analysis with SmartTime
Design Summary

Setup and Hold Checks

Cross Clock Domain Analysis

Adding User Sets and Filtering

Customizing the Analysis View

Cross-Probing with MVN Tools
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SmartTime
Customizing Analysis View

Timing Information in Path List Is Customizable
Add or Remove Columns for Each Type of Path Set

Click upper left corner to 
select entire table

Right-click in Table Header and Select 
“Customize Table”
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Timing Analysis with SmartTime
Design Summary

Setup and Hold Checks

Cross Clock Domain Analysis

Adding User Sets and Filtering

Customizing the Analysis View

Cross-Probing with MVN Tools
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SmartTime
Cross-Probing with MultiView Navigator

Cross-probe between SmartTime and MVN Tools

Path Highlighted in 
ChipPlanner

Select path 
and right click



Timing Reports
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SmartTime
Timing Reports

SmartTime Can Generate Two Types of Reports:
Timing Report
Timing Violation Report

Timing Report Contains Timing Information of the Design in 
a Text Format

Information Can Be Customized

Timing Violation Report Contains a Flat List of Paths With 
Timing Violations (No Breakdown by Clock Domain).
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SmartTime
Timing Report Options

Include Summary in Timing Report
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SmartTime
Timing Report Options

Paths & Sets Options
Include User Defined Sets in Timing Report
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SmartTime
Timing Report Options

Clock Domains
Specify Clock Domains to be Included in the Timing Report
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SmartTime
Timing Report Structure

Header
Design Information, Operating Conditions…

Summary
Data-sheet (Freq, ext setup/hold, min/max clock-to-out…)

Clock Domain Details
Path Sets (reg2reg, in2reg, reg2out, Custom…)

Path Details
Expanded Paths

Inter-clock Domain Details

Pin-to-pin Path
Path Sets (in2out, Custom…)
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SmartTime
Summary Section in Timing Report

Clock Domain: p_spi_clk
Period (ns): 9.334
Frequency (MHz): 107.135
External Setup(ns): 2.103
External Hold( ns): 2.599
Min Clock-To-Out (ns): 5.302
Max Clock-To-Out (ns): 8.261

Clock Domain: q_spi_clk
Period (ns): 9.334
Frequency (MHz): 107.135
External Setup(ns): 2.103
External Hold( ns): 2.599
Min Clock-To-Out (ns): 5.302
Max Clock-To-Out (ns): 8.261

In-to-Out:
Min Delay (ns): 4.569
Max Delay (ns): 8.246
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SmartTime
Clock Details in Timing Report 1/2

Clock Domain: p_spi_clk
Path-Set Register-to-Register

Path 1
From: B_mbuf/r_adr[0]:CLK
To: B_mbuf/clear[1]:D
Delay: 8.090
Slack: -5.218
Arrival: 16.331
Departure: 11.113
Minimum period: 0.2359
Skew: 45.023

Path 2
-------

Path 3
-------

Expanded path 1
-------

Path-Set In-to-Register
.....
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Clock Domain: p_spi_clk
Path-Set Register-to-Register

Path 1
Path 2
Expanded path 1

-----------------------------------------------------------
Total(ns)  Op   Delay(ns) PinName (edge)

Type/name
0.000        p_spi_clk

+   1.912 Clock network
1.912 B_mbuf/r_adr[0]:CLK (r)

+   0.257 Cell: ADLIB:AO21TTF
2.169 B_mbuf/clear_d_1[1]:Y (f)

+   0.289 Net: B_mbuf/clear_d_1[1]_net_1
2.458 B_mbuf/clear[1]:D (f)

2.458 data arrival time
______________________________________________________________

4.000     p_spi_clk
+   1.879 Clock network

7.879 B_mbuf/clear[1]:CLK (r)
- 0.766 Library setup ADLIB:DFFC

7.113 B_mbuf/clear[1]:D

7.113 data required time
______________________________________________________________

7.113 data required time
2.458 data arrival time
4.655 slack

Path-Set In-to-Register
.....

SmartTime
Clock Details in Timing Report 2/2
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SmartTime
Timing Violations Report Options

General Options
Specify Maximum or Minimum Delay Analysis
Enter Slack Threshold
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SmartTime
Timing Violations Report Options

Path Options
Limit Number of Reported Paths
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SmartTime
Violation Report Structure

Header
Design Information, Operating Conditions…

Paths
List of Paths With Timing Violations
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SmartTime
Violation Report
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SmartTime 7.2 New Features
Clock Source Latency

Asynchronous Signals

Datasheet Report

Ease-of-Use
Analyzing the clock network
Path Set improvements
Automatic creation of Generated clocks
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Clock Source Latency: Analysis
Pin Name Type Net Name Cell Name Op Delay (ns) Total (ns) Fanout Edge
From: irci:CLK
To: iry1:D
data required time 6.566
data arrival time - 8.285
slack -1.719

clk 0.000 0.000
Clock source latency + 0.500 0.500 r

irci:CLK Clock network + 5.573 6.073 r
irci:Q cell ADLIB:DFEG + 0.673 6.746 1 r
iadd2/add0_FCINST1:A net rci + 0.151 6.897 r
iadd2/add0_FCINST1:FCO cell ADLIB:FCINIT_BUFF + 0.543 7.440 1 r
iadd2/add0:FCI net iadd2/add0_FCNET1 + 0.000 7.440 r
iadd2/add0:FCO cell ADLIB:ADD1 + 0.075 7.515 1 r
iadd2/add1:FCI net iadd2/c0 + 0.000 7.515 r
iadd2/add1:S cell ADLIB:ADD1 + 0.610 8.125 1 r
iry1:D net sy[1] + 0.160 8.285 r
data arrival time 8.285

clk Clock Constraint 4.000 4.000
Clock source latency + -0.250 3.750 r

iry1:CLK Clock network + 3.050 6.800 r
iry1:D Library setup time ADLIB:DFEG - 0.234 6.566
data required time 6.566

Data arrival time calculation

Data required time calculation

Late
Launch

Early
Capture
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Removal/Recovery Checks
Definition

An asynchronous signal should not be de-activated around 
the active clock edge

Recovery needs to be checked in Max delay analysis
Removal needs to be checked in Min delay analysis
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Removal/Recovery Checks
Activation: SmartTime Options dialog

By default:
No check is done on asynchronous signals
Signals don’t propagate through asynchronous pin of registers
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Removal/Recovery Checks
Example: Active low reset with synchronous de-
activation
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CLR
D Q

CLK CLR
D Q

CLK

Reset

Clock

CLR
D Q

CLK

Removal/Recovery Checks
Recovery/Removal Check

Minimum period is limited by the propagation between the reset 
register and the other registers.
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CLR
D Q

CLK CLR
D Q

CLK

Reset

Clock

CLR
D Q

CLK

Removal/Recovery Checks
External Recovery/Removal



© 2006 Actel Confidential and Proprietary 458September, 2006Introduction to Libero v7.2.2

CLR
D Q

CLK CLR
D Q

CLK

Reset

Clock

CLR
D Q

CLK

Removal/Recovery Checks
External Setup/Hold
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Removal/Recovery Checks: Analysis
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Datasheet Report
Content

Pin Description
Pin location on the package
Port name
Type (input, output, inout, clock)
I/O Technology used

DC Timing Characteristics
Electrical parameters of each I/O technology (slew, output 
load, voltages,)

AC Timing Characteristics
External Timing Requirements

New analysis view in the SmartTime Analyzer

New report
Text format or CSV (Comma Separated Value)
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Datasheet: AC Timing Characteristics
Maximum clock frequency for all external clocks

External Setup/Recovery/Hold/Removal for each input 
ports with respect to external clocks

Clock-to-out for output ports

Input-to-Output for combinational paths
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Datasheet: Example
Pin Description
+-------+----------+--------+-----------+
| Name  | Location | Type   | Techno    |
+-------+----------+--------+-----------+
| a[0]  | J14      | Input  | LVCMOS15  |
| b[0]  | H15      | Input  | LVCMOS25  |
| reset | K1       | Input  | SSTL2I    |
| ci | B8       | Input  | LVTTL (1) |
| clk | R7       | Clock  | GTLP25    |
| y[0]  | C9       | Output | LVTTL (2) |
| co    | B7       | Output | LVTTL (3) |
| en    | L2       | Input  | PCI       |
+-------+----------+--------+-----------+

DC Electrical Characteristics
+-----------+------+----------+-------+-----------+------+--------+------+--------+
| Name      | Vcci | Resistor | Input | Hot       | Vccr | Output | Slew | Output |
|           | (V)  | Pull     | Delay | Swappable | (V)  | Drive |      | Load   |
|           |      |          |       |           |      | (mA)   |      |        |
+-----------+------+----------+-------+-----------+------+--------+------+--------+
| GTLP25    | 2.5  |          | no    | yes       | 1    |      |      |        |
| LVCMOS15  | 1.5  | Up       | no    | yes       |      |      |      |        |
| LVCMOS25  | 2.5  | None     | no    | yes       |      |      |      |        |
| LVTTL (1) | 3.3  | None     | no    | yes       |      |      |      |        |
| LVTTL (2) | 3.3  | None     |       | yes       |      | 24   | Low  | 35     |
| LVTTL (3) | 3.3  | None     |       | yes       |      | 12   | High | 40     |
| PCI       | 3.3  |          | no    | no        |      |      |      |        |
| SSTL2I    | 2.5  |          | no    | yes       | 1.25 |      |      |        |
+-----------+------+----------+-------+-----------+------+--------+------+--------+
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Datasheet: Example

AC Electrical Characteristics
+-------------------+------------+--------+------------+--------+---------+------+
| Description       |            |        |            | Min    | Max     | Unit |
+-------------------+------------+--------+------------+--------+---------+------+
| Clock frequency   | clk |        |            |        | 189.143 | MHz  |
| Clock period      | clk |        |            | 5.287  |         | ns   |
| Setup time        | a[0]       | before | clk (rise) | -0.946 |         | ns   |
| Setup time        | b[0]       | before | clk (rise) | -2.642 |         | ns   |
| Setup time        | ci | before | clk (rise) | -3.100 |         | ns   |
| Setup time        | reset      | before | clk (rise) | -0.096 |         | ns   |
| Hold time         | a[0]       | after  | clk (rise) | -1.278 |         | ns   |
| Hold time         | b[0]       | after  | clk (rise) | -2.062 |         | ns   |
| Hold time         | ci | after  | clk (rise) | -2.241 |         | ns   |
| Hold time         | reset      | after  | clk (rise) | -0.429 |         | ns   |
| Recovery time     | reset      | before | clk (rise) | -0.266 |         | ns   |
| Removal time      | reset      | after  | clk (rise) | -0.429 |         | ns   |
| Propagation delay | clk (rise) | to     | co         | 3.545  | 7.420   | ns   |
| Propagation delay | clk (rise) | to     | y[0]       | 6.720  | 14.309  | ns   |
+-------------------+------------+--------+------------+--------+---------+------+
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Pin Name Type Net Name Cell Name Op Delay (ns) Total (ns) Fanout Edge
From: irci:CLK
To: iry1:D
data required time 6.816
data arrival time - 7.785
slack -0.969

clk 0 0
irci:CLK Clock network + 5.573 5.573 r
irci:Q cell ADLIB:DFEG + 0.673 6.246 1 r
iadd2/add0_FCINST1:A net rci + 0.151 6.397 r
iadd2/add0_FCINST1:FCO cell ADLIB:FCINIT_BUFF + 0.543 6.94 1 r
iadd2/add0:FCI net iadd2/add0_FCNET1 + 0 6.94 r
iadd2/add0:FCO cell ADLIB:ADD1 + 0.075 7.015 1 r
iadd2/add1:FCI net iadd2/c0 + 0 7.015 r
iadd2/add1:S cell ADLIB:ADD1 + 0.61 7.625 1 r
iry1:D net sy[1] + 0.16 7.785 r
data arrival time 7.785

clk Clock Constraint 4 4
iry1:CLK Clock network + 3.05 7.05 r
iry1:D Library setup time ADLIB:DFEG - 0.234 6.816
data required time 6.816

Data arrival time calculation

Data required time calculation

Clock Network Details

Skew = 5.573  – 3.05  = 2.523 ns

-0.969
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Clock Network Details
Menu: Tools > Options
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Clock Network Details
Pin Name Type Net Name Cell Name Op Delay (ns) Total (ns) Fanout Edge

data required time 6.816
data arrival time - 7.785
slack -0.969

clk 0 0
clkin/U0/U0:PAD net clk + 0 0 r
clkin/U0/U0:Y cell ADLIB:IOPAD_IN + 1.652 1.652 1 r
clkin/U0/U1:A net clkin/U0/NET1 + 0 1.652 r
clkin/U0/U1:Y cell ADLIB:RCLKMUX + 0.116 1.768 4 r
ien:B net sclk + 1.28 3.048 r
ien:Y cell ADLIB:AND2 + 0.725 3.773 1 r
ickint/U1:A net enclk + 0.286 4.059 r
ickint/U1:Y cell ADLIB:CLKINT_W + 0.116 4.175 1 r
ickint/U0:A net ickint/NET0 + 0 4.175 r
ickint/U0:Y cell ADLIB:RCLKMUX + 0.116 4.291 5 r
irci:CLK net gclk + 1.282 5.573 r
irci:Q cell ADLIB:DFEG + 0.673 6.246 1 r
iadd2/add0_FCINST1:A net rci + 0.151 6.397 r
iadd2/add0_FCINST1:FCO cell ADLIB:FCINIT_BUFF + 0.543 6.94 1 r
iadd2/add0:FCI net iadd2/add0_FCNET1 + 0 6.94 r
iadd2/add0:FCO cell ADLIB:ADD1 + 0.075 7.015 1 r
iadd2/add1:FCI net iadd2/c0 + 0 7.015 r
iadd2/add1:S cell ADLIB:ADD1 + 0.61 7.625 1 r
iry1:D net sy[1] + 0.16 7.785 r
data arrival time 7.785

clk Clock Constraint 4 4
clkin/U0/U0:PAD net clk + 0 4 r
clkin/U0/U0:Y cell ADLIB:IOPAD_IN + 1.652 5.652 1 r
clkin/U0/U1:A net clkin/U0/NET1 + 0 5.652 r
clkin/U0/U1:Y cell ADLIB:RCLKMUX + 0.116 5.768 4 r
iry1:CLK net sclk + 1.282 7.05 r
iry1:D Library setup time ADLIB:DFEG - 0.234 6.816
data required time 6.816

Data arrival time calculation

Data required time calculation

From: irci:CLK
To: iry1:D

Source 
Clock 
Network

Sink Clock 
Network
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Clock Network Details
Schematic
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Path Set Management
Specify an exception for an 
entire set

Modify existing sets

Create/Edit/Delete sets using 
Tcl
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Exporting SDC Timing Constraints
Constraints Entered in SmartTime GUI Can Be 
Exported from Designer
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Importing SDC Timing Constraints
SDC Timing Constraints Can Be Imported into Designer 
as Source File or Auxiliary File

Source Files are Audited
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Constraint Recommendations
Set Realistic Constraints

Set Sufficient Constraints

Don’t Over constrain
Improperly-Constrained Design Can Lead to Long Run 
Times, Multiple Iterations and/or Sub-optimal Results
max_delay Is Not Equivalent to Clock Constraint or Clock 
Period 
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Layout
Assign Physical Locations to Unassigned I/Os

Place Logic Modules 

Assign Routing Tracks to Nets 

Calculate Detailed Delays for All Paths
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Layout Options
ProASIC3\E

Layout Mode
Timing-Driven: Constraints Defined 
in SmartTime

De-selecting Causes Standard 
Layout to be Used

Place and Route Tools
Can Be Turned On or Off

Incremental Placement and Routing

Multi Pass Layout Option

Advanced Layout Options
High Effort Placer

Known Limitations
Router Cannot Run in Incremental 
Mode if there Has Been Change in 
Global Assignments

Users Must Manually Uncheck 
Incremental Routing Option and Re-
run Layout
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Designer High Effort Placer
ProASIC3\E

“High Effort” timing-driven placer mode
Performs greater optimization of the placement at the expense of
extra runtime
The objective is to further increase performance

Placer is guided by highly detailed feedback from continuous timing 
evaluations

Based on new high speed timing analysis that operates using 
incremental changes in the placement algorithms

Improvement over Designer 6.2
Additional 3% average QOR increase (total 10% QOR increase)
Reduced Runtime penalty (average is 2x vs. 3x – 4x)

Initiated via Advanced Layout Options and Tcl
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ProASIC3\E Local Clock Assignment
Finds and creates legal clock assignments for clock nets not already 
assigned by the user

Runs automatically as part of layout

Performs Auto-assignment of nets given certain criteria
Runs when > 6 globals (or > 2 PLLs are detected)

Globals come from user netlist or PDC constraints
CCC macro instantiation
Global promotion through PDC constraints

If > 6 global nets, LCA will assign the global nets to 
Chip wide globals or
Quadrant regions 

The choice of chip wide globals or a quadrant region will depend on
Fanout of the nets
Resources and user constraints
Shared loads
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Layout Options
ProASICPLUS

Layout Mode
Timing-Driven: Constraints Defined in 
SmartTime

De-selecting Causes Standard Layout 
to be Used

Place and Route Tools
Can Be Turned On or Off

Incremental Placement and Routing
Lock Existing Placement:  Treats All 
Unchanged Macros as Fixed 
Placements

Multiple Passes
P&R Runs Multiple Times

Specify:
Number of Iterations
What to Optimize (Specific Clock, 
Timing Violations, etc.)
Which Results to Save (Best or All)
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Layout Options
Axcelerator

Layout Mode
Timing-Driven: Constraints Defined in 
SmartTime

De-selecting Causes Standard Layout 
to Be Used

Place and Route Tools
Can Be Turned On or Off

Incremental Placement and Routing
Lock Existing Placement:  Treats All 
Unchanged Macros as Fixed 
Placements

Placement Effort Level
Provides Degree of Control over 
Timing-Driven Placement Engine
Range is from “Low” to “High”

Multiple Passes
P&R Runs Multiple Times
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Layout Modes
SX Architecture

Layout Mode
Timing-Driven: Constraints Defined in 
SmartTime (SX-A) or Timer (SX)

De-selecting Timing-Driven Layout Selects 
Standard Layout

Incremental Placement
Lock Existing Placement: Treats All 
Unchanged Macros as Fixed Placements

De-selecting Allows Placer to Relocate 
Unchanged Macros if Necessary

Multiple Passes
P&R Runs Multiple Times

Advanced Options Allow Additional 
Control of Timing-driven Placement 
Engine

SX, SXA and eX Families
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Advanced Layout Options
SX Architecture

Extended Run
Directs Layout to Use Larger Number of Iterations during 
Optimization to Improve Layout Quality

Causes Layout to Run up to 5 Times Longer

Effort Level
Specifies Duration of Timing-driven Phase of Optimization during 
Layout as Percentage of Default Duration 

Default Value is 100
Selectable Range from 25 to 500

Reducing Effort Level also Reduces Run Time of Timing-driven 
Place and Route (TDPR).

With Effort Level of 25, TDPR Is Almost Four Times Faster than 
Default of 100

However, with Fewer Iterations Performance May Suffer
Routability May or May Not Be Affected
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Advanced Layout Options (cont.)
SX Architecture

Timing Weight
Setting this Option Changes Weight of Timing Objective Function

Recommended Range: 10 - 150 (Default is 100)
Bias TDPR in Favor of either Routability or Performance

Weight Is Specified as Percentage of Default Weight
Value of 100 Has No Effect 
Value Less than 100 – More Emphasis on Routability and Less on 
Performance

Appropriate for Design that Fails to Route with TDPR 
Value Higher than 100 – More Emphasis on Performance

BUT … Very High Value of Timing Weight Might Degrade Performance!



© 2006 Actel Confidential and Proprietary 481September, 2006Introduction to Libero v7.2.2

Which Layout Mode to Use?

Are estimates 
well within 

design specs
?

Analyze the pre-layout estimates

No constraints needed
(Use Standard Mode Layout)

Apply constraints within 
SmartTime (or Timer) and 
Use Timing-Driven Layout

Are estimates
within 15% of
design specs

?

Yes

Yes

No
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Completed Layout
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Exporting SDF File
Extract Timing delays
for post-layout simulation



SmartPower
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SmartPower

SmartPower Supports Fusion, 
ProASIC3/E, ProASICPLUS, 
ProASIC and Axcelerator

SmartPower Icon Not Visible for 
other Families

SmartPower Report Contains 
Clock Domains, Set of Pins, and 
Annotated Pins

Detailed Information Available in 
Designer Documentation

SmartPower.pdf

SmartPower icon
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SmartPower GUI
5 Display Tabs

Summary
Total Static and Dynamic Power of Design
Average Switching Activity of Clock Pins 
and Data Pins of Selected Clock Domain
Impact of Power Consumption on Junction 
Temperature for Given Cooling Scenario

Domains
Shows List of Existing Clock Domains with 
their Corresponding Frequencies

Analysis
Provides Detailed Hierarchical Reports of 
Dynamic Power Consumption

Activity
Allows Entry of Switching Activity 
Information for Clock and Data Inputs in 
Design

Enable Rates
Specify Enable Rates for each Tri-state and 
Bi-Directional I/O
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SmartPower Summary Tab
Displays:

Static and Dynamic Power
Junction Temperature

Design Level
Power Summary

Calculated Junction Temp
Cooling Type

Ambient Temp
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SmartPower Domains Tab
Shows Clock Domains with their Corresponding 
Frequencies

Pin management 
window 
- add pin to the 
current domain

Domain 
management 
window 
– add domains 
or select an 
existing domain

Create New 
Domain

Delete selected 
domain

Filter Boxes
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SmartPower Notes
Design must be in post-layout state to launch 
SmartPower

Designer will run layout if SmartPower is launched in pre-
layout state

When SmartPower is launched the first time, all clock 
domains are assigned a frequency of 10 MHz and all 
data frequencies are set to 1 MHz.

Specify true clock and data rates to accurately estimate 
power consumption.
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SmartPower
Analysis Tab

Provides Detailed Hierarchical Reports of Dynamic Power Consumption

Report
Window

Hierarchy 
Instances 
Window

Reported
Values
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SmartPower Activity Tab
Allows Entry of Switching Activity Information on 
Interconnects of Design

Selected Clock 
Domain

Non-
Annotated 
Pins

Specified 
Frequency

Global 
Frequency

Pin Type
Annotated 
Pins
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SmartPower Enable Rates Tab
Specify the Output Enable Rate 
of each tri-state and 
bidirectional I/O

The enable rate is the 
percent of time that the I/O is 
driving 
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SmartPower
Importing a VCD File

Switching information for the 
design can be entered by 
importing a VCD or SAIF file

Import as an Auxiliary file
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SmartPower Preferences
Max List Size Allows Limiting Instances or Pins Listed

Units, Operating Conditions,
and List Sort Controls Are Self-explanatory

Block Expansion Control Allows Reported Values to Be 
Filtered by Minimum Power, Minimum Power Ratio, or 
Maximum Hierarchical Depth
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SmartPower Power Report
Text Format

Select Hierarchical, Flat or Breakdown 
as Report Style

Select Static and/or Dynamic Power for 
Reporting

Options Menu Invokes Preferences 
Menu
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SmartPower 7.2
New Features

Power Breakdown
Breakdown by type in Summary (I/Os, gates, nets, clocks, 
memories…)
Breakdown by power rail in Summary (VCCA, VCCI 3.3, 
VCCI 2.5….)
Breakdown by type also available for any level of Hierarchy 
in the Analysis Tab

Advanced Dynamic I/O power analysis
The Power of all I/Os is reported in Summary/Breakdown
To make it easier, we display I/O attributes (Load, Standard, 
Drive Strength…)
You can set output enable rates for each bidirectional and 
tri-state (new Enable-rates Tab)

Additional Ease-of-Use Features
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SmartPower 7.2
Power Breakdown
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Post-Layout Simulation

Post-Synthesis Simulation

Design Capture

Synthesis

Programming

Simulation

Place & Route

Post-P&R Simulation
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Post-Layout Simulation

Steps
Route design
Export .sdf file (Back-annotate)
Run Post-layout Simulation

SDF File Contains Delays for Min, Typ and Max
(DELAYFILE
(SDFVERSION "2.1")
(DESIGN "counter")
(VOLTAGE 2.70:2.50:2.30)
(PROCESS "WORST")
(TEMPERATURE 0:25:70)
(TIMESCALE 100ps)

(CELL
(CELLTYPE "OUTBUF")
(INSTANCE COUNT_pad_12)
(DELAY
(ABSOLUTE

(PORT D (1.65:2.55:3.52) (2.21:3.40:4.62))
(IOPATH D PAD (19.19:28.90:39.88) (17.49:26.35:38.85))

)
)
) rising 

min:typ:max
falling 

min:typ:max
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Post-Layout Simulation
Click on “Simulation” in Design Flow Window or…

Right
Mouse
Click!

Double
Click!
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Post-Layout Simulation
Structural Netlist and .sdf File 
Used for Simulation

Simulator runs for 1 uS as 
Default
Max Operating Conditions 
Default
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Post-Layout Simulation
Selecting Operating Conditions

Post-layout Operating 
Conditions Can Be Specified 
within Libero

Tools > Options from Libero 
Main Window
Select Simulation Tab in 
Options Window
Choose Min/Typ/Max
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Programming & Debugging

Post-Synthesis Simulation

Design Capture

SynthesisSimulation

Place & Route

ProgrammingPost-P&R Simulation
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Generating Programming File
Antifuse

Generate fuse file (.afm)

Generate file for Silicon Explorer 
debug

Specify a unique 5 digit silicon 
signature to program into device
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Generating Programming File
Flash

Generate programming  
file (bitstream or STAPL)

File Format Contains Programmer
Bitstream Raw Data Sculptor, Sculptor II

STAPL

Raw Data plus 
programming 
information

Sculptor, Sculptor II, 
FlashPro, FlashPro Lite, 
FlashPro3,                         
In-system programming

Select output file type
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Sculptor II Overview
PC-based Parallel-port, Single Device Programmer

Designed to Allow Concurrent Programming of Multiple 
Units from Same PC

Replaces Silicon Sculptor I as Actel's Programmer of 
Choice 

Silicon Sculptor II Benefits: 
Programs All Actel Packages

Antifuse and Flash Programming Support 
Universal Actel Socket Adapters 
Works with Silicon Sculptor I Adapter Modules 
Uses Same Software as Silicon Sculptor I 
Provides Extensive Self-test Capability 
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Available from Actel Website
http://www.actel.com/custsup/updates/silisculpt/

Requirements (Windows Version)
Microsoft Windows 95/98, Win NT or Win 2000

Requirements (DOS Version)
286 with 4MB RAM, Approx. 6MB Hard Drive Space
DOS-driven Program - Memory Managers Not Required
DOS Shell from Windows 95/98 - OK
Does Not Work with Windows NT

Sculptor II Software
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1.  Select > Device
2.  Buffer > Load

Checksum Command (under the pull 
down menu) compares checksum on 
the chip to FUSCHECKSUM in the 
.afm file.

Programs the design fuses.

Programs the security fuse.

Status Area

Check to see if the chip is blank.

Silicon Sculptor II Windows Interface
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Silicon Sculptor II DOS Interface

1.  Select > Device

2.  Buffer > Load
Compares checksum on the chip to 
FUSCHECKSUM in the .afm file.

Checks to see if the chip is blank.

Programs the design fuses.

Programs the security fuse.

Status Area
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Flash Programming
Flash FPGA Devices Can Be Programmed Multiple Ways

Off-board Programming with Silicon Sculptor II
In-System Programming (ISP) using JTAG Interface with:

Silicon Sculptor II (ProASIC, ProASICPLUS, ProASIC3\E, Fusion)
Flash Pro (ProASIC or ProASICPLUS)
Flash Pro Lite (ProASICPLUS)
Flash Pro 3 (ProASIC3\E, Fusion)

Programming via Microprocessor Interface
(ProASICPLUS, ProASIC3\E, Fusion)
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FlashPro Programmer
ProASIC, ProASICPLUS

Small Form Factor - 24 in3

Low Cost 
Hardware Features

Small 26-pin Header
Samtec FTSH-113-01-L-D-K

20” Ribbon Cable

ECP Parallel Port

Software Features
Win 95/98/NT/00 O/S

STAPL Support
Daisy Chain Capability

Log File Generation
Self-test Option
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FlashPro Lite Programmer
ProASICPLUS

Low Cost 

Ultra-small Form Factor

Hardware Features
Draws Power from Target Board
Connects to Parallel Port 
Supports In-system Programming

Samtec 26-pin Header

Software Features
Supports Windows 98, NT, 2000, and XP Operating Systems 
STAPL Support 
Free Software Updates 
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FlashPro 3
ProASIC3\E and Fusion

USB 2.0 High-speed Interface
10-pin JTAG ISP
Altera-compatible Interface

Programs ProASIC3 Devices in Less than 2 Minutes

Powered by USB Connection
Parallel Programming Requires Powered USB Hub

Variable TCK (up to 24 MHz)
Recommend <= 20MHz for PA3/E

Optional Transition Board provides Adapter Cables for 26- and 10-
pin SAMTEC
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Programmer Summary

Programmer Device Support Availability

Silicon Scupltor II

All antifuse FPGAs               
ProASIC and ProASICPLUS  

ProASIC3\E Available

FlashPro ProASIC and ProASICPLUS  Available
FlashPro Lite ProASICPLUS  Available

FlashPro 3 ProASIC3\E and Fusion Available
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FlashPro 4.2 User Interface
Menu Bar

Tool Bar

Log 
Window

Flow 
Window

Status Bar
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Programming with FlashPro 4.2
Launch FlashPro

Load STAPL File

Select Action

Execute Action
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FlashPro 4.2
Create / Open Project

Select New or Open in FlashPro 4.2 GUI to Create a 
Project or Open and Existing Project

Create New 
Project
Open 
Existing 
Project
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FlashPro 4.2
Load STAPL File

Select Configure STAPL File to Load Programming File
Single STAPL File Configuration Window is Displayed

Browse to 
STAPL file
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FlashPro 4.2
Select Action

Select Action to Perform from Pull-down Menu in Single 
STAPL Configuration Window

Select Action 
from pull-down 
menu

STAPL file 
details
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FlashPro 4.2
Execute Action

Click Button in Flow Window to Execute Action
Button Matches Selected Action
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FlashPro 4.2
Programmer Status

Programmer Status is Displayed in Programming List 
Window

Programming 
List Window

Programmer 
Status
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FlashPro 4.2
Programming Complete

Successful Programming is Indicated in the 
Programmer Status Column
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FlashPro 4.2
Connecting Multiple Programmers

FlashPro 4.2 Supports Connecting Multiple Programmers 
To One Computer

Select or un-select 
all programmers
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Invoking Programming Software from 
Libero
Click on “Programming” in Design Flow Window or…

Double
Click!

Right
Mouse
Click!



ChainBuilder
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ChainBuilder
Overview

ChainBuilder Allows ProASIC3\E and ProASICPLUS FPGAs
to be Programmed in JTAG Chains Containing non-
Actel Devices

3 2 1 TDOTDI

Control lines

APA150 Non-Actel APA300

Programmer
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ChainBuilder
Features

Main Features
GUI Assignment of STAPL Files to Individual Fusion, 
ProASIC3\E and ProASICPLUS Devices
Builds Single STAPL File to Program Multiple Devices in 
Chain
Project File for Portability

Non-Actel Device Support
BSDL Support to Define non-Actel Devices
IR (Instruction Register) Length Entry to Define non-Actel 
Devices

Serial Programming
Devices Programmed One at a Time
Two Devices = Twice the Programming Time
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ChainBuilder
Main Window

Tool Bar

Output File

Main Window:
Lists the devices in the chain
Lists the associated STAPL 

file (for APA devices)
Can bypass devices that are 

not going to be programmed
Non-APA devices are 

forced to bypass
Copy, export or print the list 

of devices in the chain

Output Window:
Lists Warnings and Error 

Messages
Warning means there is an 

error but the STAPL file can be 
generated

Error implies STAPL file will 
not be generated

Output window can be 
copied, exported or printed
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ChainBuilder
Adding a Device

Actel Device
Lists Actel Devices Available
User Can Specify Custom Name
User Can Select STAPL File

Non-Actel Device
User Can Select BSDL File

Provides Max TCK Frequency and 
IR Length for Device

Users Can Enter Data Directly if 
They Do Not Have Access to 
BSDL File
User Can Enter Custom Name for 
Device
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ChainBuilder
Adding a Device (cont.)
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ChainBuilder
Bypass Feature

If Device is Checked in Bypass Column, Device Is 
Bypassed in Chain

No Functions (such as Programming) Are Performed on it 

Bypass checkbox
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ChainBuilder
Generate STAPL File

Click Generate STAPL File Button to Generate STAPL 
File for JTAG Chain
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Silicon Explorer
Debug Designs in Real Time!

Select Internal FPGA Nodes on the Fly for Viewing while 
Device Runs at FULL Speed!
Reduce Debug Time and Decrease your Time to Market!

Design

Prototype

Select 
Nodes

Observe
Results

Debug
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Preparing for Debug
If Possible, Avoid Using Probe 
Pins for Regular User I/O

Make Probe Pins Accessible
Jumper Leads, Dedicated 
Connector

Reserve Probe pins during compilation
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Preparing for Debug (cont.)
Silicon Explorer Used for Debugging

Can Probe any Two INTERNAL Nodes in Real Time
Four Internal Nodes for Axcelerator 

Also Functions as 18-channel Logic Analyzer

Needs Only .prb File to Allow Debugging. 

Security Fuse Should NOT Be Programmed on Device

Generate Probe file
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Action Probe Circuitry
Dynamic Internal Node Access

No Changes to Timing 
Relationships
No Changes to Fan-out or 
Node Loading

Patented Architectural Feature
Antifuse Devices Only
Unique to Actel

No Silicon Overhead
Uses Zero Logic Resources
Always there if Needed

Control

Registers
R

egisters
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Silicon Explorer Setup
SX/SX-A/eX

Silicon
Explorer

Serial
Connection SX/SXA

TMS
TDI
TCK D Q

PRB

PRA

TDO

18 Logic Analyzer
ChannelsWindows PC



© 2006 Actel Confidential and Proprietary 539September, 2006Introduction to Libero v7.2.2

Silicon Explorer II
Action Probe Control

Serial Port Connection
No Plug-in Cards

High-speed Signal Acquisition

Sampling Rate
100MHz Asynchronous
66 MHz Synchronous

Analyze PC-hosted Software

Optional External Power Supply 
(Recommended for SX-A)

Multilevel Triggering
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Silicon Explorer Software

Flexible Signal Assignment
Signal Grouping, Bussing

Decimal, Hex, Binary, 
Analog Radix Selection for 
Bussed Signals

Edge and Level Trigger 
Selection
64K Samples per Channel

Easy-to-learn, Easy-to-use 
Interface

Full-featured 18 channel Logic Analyzer
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Designer Cross-Probing
Designer Allows you to Verify 
and Optimize your Design

Silicon Explorer II Helps you 
Perform In-system Debugging

Cross-Probing Links All Design 
Views
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Invoking Silicon Explorer
Click on “Silicon Explorer” in Design Flow Window

Double
Click!
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Summary
Libero FPGA Design Suite Includes:

Design Entry
ViewDraw, HDL Editor, SmartGen

Synthesis
Synplicity

Physical Synthesis
Magma PALACE

Verification
ModelSim, WaveFormer Lite

Designer (P&R, Timing Analysis and Constraints)

Actel Continues to Improve Libero IDE
Increased Quality of Results
Ease of Use
Additional Features



Back-up Slides



SDC Constraints
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SmartTime 
Supported SDC Constraints

Synopsys Design Constraint (SDC) is the Accepted File 
Format for Timing Constraints 

SmartTime Supports the Following SDC Constraints: 
create_clock
set_input_delay
set_output_delay
set_false_path –from –through –to
set_ multicycle_path –from –through –to
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Timing Constraints 
Board-Level View

Constraining FPGA Designs with SDC

Source: Mentor Graphics Corporation ©, 2002

create_clock

set_multicycle_path

set_false_path

set_output_delay

set_input_delay
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Clock Constraints in SDC
create_clock

Specifies Clock Domain Frequency

Features
Propagation Delays Are Computed to Each Flip-flop
Clock Skew Is Computed for Each Connected Pair of Flip-flops
Setup and Hold Checks Are Performed for Constrained Clock 
Domains

Syntax:
create_clock -period period_value [-waveform edge_list] 
source

create_clock  -period 2.0 [get_ports {CK}]

F
F
2

F
F
2

MyDesign

Clock 
Generator

F
F
1

F
F
1

CK
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Input Delays in SDC
set_input_delay

Specifies Arrival Time at an Input Port Relative to a Clock Edge

MyDesign

Clock
Generator

CK

IN1

SDC: set_input_delay 2.00 -clock {CK}  {IN1}

2.0ns

CK

3.0ns
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Output Delays in SDC
set_output_delay

Specifies the Amount of Time Before a Clock Edge for Which the Signal 
is Required.

2.0ns

MyDesign

CK

CK

OUT1

SDC: set_output_delay –max 3.00 -clock {CK} {OUT1}

3.0ns

Option “-min” for hold check
Option “-max” for setup check
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False Paths in SDC
set_false_path

Identifies Paths that are Considered False and Excluded 
from the Timing Analysis.

Syntax
set_false_path [-from from_list] [-through through_list]   

[-to to_list]

SDC: set_false_path –through i1 i2 i3 i4 i5 i6 i7
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Multicycle Paths in SDC
set_multicycle_path

Specifies Paths Where Allowable Data Path Delay Is More 
Than One Clock Cycle

Syntax:
set_multicycle_path ncycles [-from from_list]                     

[–through through_list] [-to to_list]

CKsource

CKsink

New setup relationshipDefault setup relationship

set_multicycle_path  2 -from [get_pins {FF1*}] -to {FF3:D}

F
F
3

F
F
3

MyDesign

Clock 
Generator

F
F
1

F
F
1

CK


